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 What Is MS Excel?  
 
    Microsoft Excel is a spreadsheet application for storing and analyzing numerical and mathematical data. Microsoft Excel includes a variety of resources for performing tasks such as equations, pivot tables, graphing tools, macro programming, and more. It works for a variety of operating systems, including Windows, Mac OS, Android, and iOS.  
 
    A table is created by a series of columns and rows in an Excel spreadsheet. Columns are customarily allocated alphabetical characters, while rows are typically assigned numbers. A cell is the intersection of a column and a row. A cell's address is determined by the letter that represents the column and the number that represents the row.  
 
    In Excel, data analysis is easy. The illustration below depicts the appearance of an Excel spreadsheet: 
 
    [image: 00001.jpeg] 
 
   

 

 How to Open Microsoft Excel?  
 
    Follow the steps below to open MS Excel on your computer:  
 
    
    	 Click on Start.  
 
    	 Then choose All Programs. 
 
    	 The next step is to open MS Office, for that, click on MS Office.  
 
    	 Finally, choose MS-Excel from the drop-down menu.  
 
    	 Alternatively, you can use the Start button and look for MS Excel in the open search box.  
 
   
 
   

 

 Main Purpose of MS Excel  
 
    Excel is a database software for saving, arranging, and editing numbers and data on a computer. It's an incredibly versatile software for figuring out responses to logic-based problems. It's software that can organize a large amount of information into graphs and tables.  
 
   

 

 Top 10 Features of MS Excel  
 
    The following are the top 10 Excel features:  
 
    Pivot Tables  
 
    They’re used to sort, count, sum, or average data, from a single spreadsheet and show it in a new chart, allowing you to cut and paste as required. That is the most critical aspect of this feature. It's simple to limit the search to revenue numbers for individual regions, product categories, or marketing platforms. This way, you can ensure that the data is free of errors.  
 
    Add Multiple Rows  
 
    Perhaps it is one of the most performed spreadsheet operations. The shortcut is Ctrl-Shift +, but it takes a while, so we suggest Right Click instead. If you choose to add more than one, pick the desired number of columns or rows, then Right Click and then Add.  
 
    Print Optimisation  
 
    Printing can be a pain for all. Imagine that anything you printed was just what you wanted to print. It is, in fact, feasible. Print preview, changing margins, fit to one page, print selection, portrait vs. landscape, printing headers, and spreadsheet-style are all things to consider. Spend the time to get acquainted with it. This is a role that you will do several times in your career.  
 
    Flash Fill  
 
    In 2013, Excel created its own unique personality. Let's just assume you have two columns of names and need to generate email addresses from both of them. Simply do that for the first row, and Excel will figure out what you're talking about and complete the rest for you. This was feasible prior to 2013, but it required a variety of steps.   
 
    Filters  
 
    Quickly explore data in a table. Filtering effectively masks non-interesting results. Typically, if you're aiming for a specific value, such as “blue vehicles,” filters would highlight those and conceal the others. However, you can now filter on a number value (e.g., is more significant than, highest 10%, etc.), and cell color in more recent iterations of Excel. Where you need to filter more than one column at the same time, such as both colors and vehicles, to locate your blue car, filtering becomes more efficient.  
 
    Conditional Formatting  
 
    Conditional formatting, when used correctly, brings out the patterns of the world as recorded by the spreadsheet. This has the potential to be sophisticated. Also, the color changes, though simple, may be beneficial. Assume that the sales department sells a certain amount of product per month. In only three clicks, you will discover the top 10% of salespeople and start a fruitful market discussion.  
 
    Paste Special  
 
    One of the more popular Excel tasks is grabbing (or copying) data from one cell and pasting it into another. However, there is a lot you might want to copy (formatting, formula, value, comments, etc.), and you might not want to copy anything. The most popular scenario is where you try to remove the formatting and save the data to your own spreadsheet using your own composition.  
 
    Absolute References  
 
    Unavoidable! F4 toggles between the four possible variations by placing a dollar in front of the letter and a dollar sign in front of the figure.  
 
    Extend Formula Across/Down  
 
    Excel’s scalability is one of the most appealing features. Excel can spit out the correct equation a million times if you have the formula correct the first time. The + crosshair is really useful. If you have continuous results, double-clicking it will carry it all the way down. You will find that copying and pasting (either standard paste or paste formulas) is more accessible.  
 
    Index-Match 
 
    It is one of the most effective Excel role combinations. It can be used to look up a value in a large table of data and then return a value in that table. Let's assume your organization has 10k workers, and you have a spreadsheet with all their records, including salaries, start date, line manager, and so on. However, you have a staff of 20 people, and you're only involved in them. This will look up the importance of your team members in the table (these must be special, such as an email address or an employee number) and display the desired details for the team. It's worth taking your time to get your mind around this because it's more versatile and efficient than VLOOKUPs.  
 
   

 

 Simplified Features of MS Excel  
 
    An Excel spreadsheet can be edited and formatted in a variety of ways. The different features of MS Excel are discussed below.  
 
    The composition of features in MS Excel is seen in the picture below:  
 
    [image: Features of MS Excel] 
 
    Home  
 
    Comprises options like font styles, font size, font color, alignment, background color, formatting options and styles, deletion and insertion of cells, and editing options.  
 
    Data  
 
    This group includes features such as adding additional data (from the web), search options, and data resources.  
 
    Insert  
 
    Inserting photos and numbers, table format and layout, adding diagrams, maps, and sparklines, equation and symbol choices, and header and footer options are all included in this tab.  
 
    Review  
 
    In the review category, proofreading (like spell check), can be performed on an excel document, and a reader can add notes in this section.  
 
    Page Layout  
 
    The page layout tab includes choices for themes, alignment, and page configuration.  
 
    View  
 
    This is where we can adjust the views under which the spreadsheet is viewed. This segment contains options for zooming in and out, as well as pane layout.  
 
    Formulas  
 
    Since MS Excel can generate tables with a vast volume of details, you can use this function to apply formulas to the table and get faster results.  
 
    

  

 

 Chapter 1. Excel Terminologies 
 
      
 
   

 

 AutoFormat 
 
    It is software that applies a preset format to cells that meet specific requirements. It may be as essential as font size and alignment. 
 
   

 

 Data Validation 
 
    This function lets you avoid entering inaccurate data into your worksheet. Drop-down lists of common words are most frequently created using this method. Data validation ensures that the data being entered is consistent and accurate. 
 
   

 

 Pivot Table 
 
    It’s a data summarization method most widely used to sort, average, and sum up data automatically. The data is retrieved from one table, and the results are shown in another. Pivot Tables make it simple to extract precise data from a vast data set. 
 
   

 

 Pivot Map 
 
    A pivot chart is a visual representation of a pivot table. The consumer can have a degree of interactivity with both the data by presenting a visual representation of the pivot table data. 
 
    A pivot area is indeed a point upon on worksheet in which you can drag a Pivot Grid field to reorganize the way a report is presented. 
 
    The information used to build your pivot table is known as source data. It may come from the worksheet itself or an external database. 
 
   

 

 Values Area 
 
    Value areas are the cells in such a pivot table that contain summary data. 
 
   

 

 Item 
 
    In your pivot table, these are sub-categories of fields. If you have a State area, the values may be Alabama, Alaska, and so on. 
 
   

 

 Worksheet 
 
    Worksheets are papers that are included inside a workbook. Workbooks, commonly known as spreadsheets, can contain several worksheets. The tabs just at the bottom of the screen will show you whichever of your worksheets you're working on right now. The active worksheet and active sheet are other names for this. 
 
    The cell is now a rectangle and block that is contained inside a worksheet. Any information you wish to use in your worksheet should be entered into a cell. Depending on what you want to achieve, cells can be color-coded, show text, numbers, and the results of calculations. A cell that is currently available for editing is known as an active cell. 
 
   

 

 Columns and Rows 
 
    Columns and rows determine the alignment of your cells. The columns are vertically oriented, while the rows are horizontally aligned. 
 
   

 

 Headings for Columns and Rows 
 
    These are all the lettered and numbered grey areas that are just outside columns and rows. When you click on a heading, the entire row/column is selected. The headings may also be used to adjust the row height and column width. 
 
   

 

 Workspace 
 
    A workspace, like worksheets in such a workbook, helps you to access several files at once. 
 
    The Ribbon is a portion of command tabs located above the workbook. Behind each tab is a plethora of choices. 
 
    The cell reference is just a collection of coordinates that uniquely defines a single cell. It is made up of numbers and letters. A5 will, for example, point to a cell at the intersection of column A or row 5. 
 
   

 

 Range of Cells 
 
    A cell range is just a series of cells grouped based on several factors. Excel will specify the set, also known as an array, using a comma (:) between cell references. A1:C1, for example, could tell a formula to looks at any cells in such a box bound by columns A and B and rows 4 and 9, while B4:D9 would inform the method to look at any cells in such a box bordered by columns A and B as well as rows 4 and 9. A 3-D reference is a range that spans several worksheets within the same workbook. 
 
   

 

 Freeze Panes 
 
    Freezing Panes makes it easy to find individual columns or rows on the worksheet to remain visible even while scrolling, like header cells that mark a column. 
 
   

 

 AutoFill 
 
    This feature allows you to copy data to multiple cells with ease. 
 
   

 

 AutoSum 
 
    It features the numbers in your sheet and shows the sum in a cell in your choice. 
 
   

 

 Merged Cell 
 
    A merged cell is formed when two or even more cells are merged. 
 
    A template is just a formatted worksheet or worksheet intended to assist users in completing a particular task in Excel. Stock research, method maps, and calendars are examples of this. 
 
    Operators are symbols and signs that signify which calculation in an expression must be performed. Operators don't have to be simple mathematical types; they can also be contrast, text concatenation, or reference operators. 
 
    A formula is a set of instructions that are entered into a cell to generate a value. It must start with an equal sign (=). A math formula, cell references, functions, or an operator may all be examples. An expression is another name for a formula. 
 
    The Formula Bar, which is located between both the Ribbon and the workbook, displays the contents of even an active cell. And in the case of equations, the equation bar may display all of the formula's components. 
 
    Functions are Excel formulas that have been pre-programmed. They're made to make potentially complicated formulas in such a worksheet easier to understand. 
 
   

 

 Error Code 
 
    If Excel detects a problem with such a formula, an error code appears. 
 
    Cell formatting is the process of altering how cell data is represented in a spreadsheet. Just the appearance of cells is altered as they are formatted; the value inside the cells remains unchanged. 
 
    Conditional formatting is used when a cell meets certain conditions, such as identical values or values above or below a certain threshold. 
 
    Filters are rules which you can use to determine which rows in such a worksheet should be shown. Data like conditions and values may be used in these filters. 
 
   



 

 Workbook 
 
    An Excel spreadsheet document is referred to as a workbook. The workbook stores all of your information and helps you to sort and measure the results. A Shared Workbook is a workbook that several users can access and edit on the same network. 
 
    

  

 

 Chapter 2. Customization of the Ribbon 
 
      
 
    Since the Excel ribbon contains the most often encountered commands, a personalized ribbon ensures a simpler and quicker Excel experience. 
 
    To customize the Ribbon in Excel, right-click somewhere on the Ribbon and pick Customize the Ribbon instead of collapsing it. 
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    The window would appear, letting users personalize the Ribbon by removing or adding commands from current or new tabs.  
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
   

 

 To Add a Command to a New Tab 
 
    
    	 Select the New tab. Under the Main Tabs section, a new tab will be created.  
 
   
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    
    	 If you like, rename it by choosing Rename and then typing in a new name. In this case, “Go skills” is used:  
 
   
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    
    	 Tab OK.  
 
   
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    
    	 Add any command (for example, Insert Picture) under the Group.  
 
   
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    
    	 Under a group of the new tab (Go skills), command (Insert Picture) shows.  
 
   
 
    [image: The Excel ribbon - Customize the Ribbon] 
 
    
    	 To confirm the customization, click OK in the bottom right corner. To the right of the Home page, a new tab called Go Skills has been added. There's a group of one command—Insert Picture—under the tab.  
 
   
 
    [image: The Excel ribbon - New Tab] 
 
    Note: Users can also customize the Group's name. The procedure is the same as renaming the tab’s name.  
 
   

 

 To Reset the Excel Ribbons 
 
    
    	 It is as necessary to reset and uninstall customizations as it is to customize them. To restore, go to Excel Options > Customizations > Reset All Customizations.  
 
   
 
    [image: The Excel ribbon - Reset] 
 
    
    	 Tab Yes and OK are mentioned on the right bottom side.  
 
   
 
    [image: The Excel ribbon - Reset] 
 
   

 

 Auto-Hide Ribbon and Show Tabs and Commands 
 
    There are shortcuts for displaying the Excel ribbons in the top left corner of the Excel window. 
 
    [image: The Excel ribbon] 
 
    
    	 To hide all tabs and commands, choose Auto-hide Ribbon.  
 
   
 
    [image: The Excel ribbon - Auto Hide] 
 
    
    	 Choose Show Tabs to see only Ribbon tabs.  
 
   
 
    [image: The Excel ribbon - Show Tabs] 
 
    
    	 Choose Show Tabs and Commands for a default view with all Ribbon tabs and commands on the screen.  
 
   
 
    [image: The Excel ribbon - Show Tabs and Ribbons] 
 
    Excel allows you to execute the most basic functions. The Excel Ribbon Interface features are divided into the following categories: 
 
    
    	 File menu button: When you first open this feature, you'll see Open, New, Save As, Export, Share, Publish, Account, Close, and other choices for changing Excel's default settings.  
 
    	 Quick access toolbar: Autosave, Undo, Save, and Redo are all available here.  
 
   
 
    [image: 00040.jpg] 
 
    
    	 Formula bar: This displays the cell's address as well as the contents of the cell.  
 
    	 Highlighted.  
 
   
 
    [image: 00041.jpg] 
 
    
    	 Worksheet area: This is where all of the cells being worked on are shown for everyone to see, with a column heading of letters and a row heading of numbers.  
 
    	 Status bar: This shows the program's current mode and lets you execute special operations on the worksheet.  
 
   
 
   

 

 Status Bar Modes 
 
    
    	 Ready mode. Nothing is being entered or modified in the spreadsheet at this time.  
 
    	 Enter mode. This mode is used for entering data and just typing in the contents.  
 
    	 Edit mode. Edit the current cell's contents. For this mode, double-click a cell with data or click within the formula bar.  
 
    	 Point mode. When using a formula or an Excel dialog window, the point mode links to cell addresses.  
 
    	 Clipboard. Windows has clipboard functions such as Cut, Copy, and Paste. A clipboard is a place where you can keep pictures and details for a short period. Just one object may be stored at a time in the Windows clipboard. The Multi Clipboard in Microsoft Office can hold up to 24 things, but the Paste button and shortcuts for the Paste option only apply to the most recently copied item. To use this tool, you must have the clipboard pane opened.  
 
    	 Cut. The selection is copied to the clipboard. The choice will vanish if it is text or a photograph. If it's a cell, Excel won't erase the original unless you paste it.  
 
    	 Copy. The selection is copied to the clipboard.  
 
    	 Paste. Retrieves the most recently copied text or object from the clipboard.  
 
   
 
    

  

 

 Chapter 3. Basics of Excel 
 
      
 
   

 

 Entering, Editing, and Managing Data in Excel 
 
    In this section, you'll start working on the workbook depicted in Figure. The skills outlined in this chapter are usually included in the preliminary stages of creating one or more worksheets in a workbook.  
 
    Entering Data  
 
    Manually inserting data into your worksheet is the first step in creating the workbook, as seen in Figure. The stages below explain how to type column headings throughout Row 2 in a worksheet:  
 
    
    	 On your worksheet, go to cell A2 and click.  
 
    	 Type in the name of a month, for example.  
 
    	 Using the RIGHT Cursor keys, transfer the cursor to the right. The term will be entered into cell A2 and the next cell on the right will be activated.  
 
    	 Click the RIGHT Cursor key to create Unit Sales.  
 
    	 Repeat Step 4 with the terms Average Price and Sales in Dollars.  
 
   
 
    Once you've typed your column headings in Row 2, check Figure 1 and see how the worksheet might look. It's worth noting that the term Price in cell C2 isn't available. This is because the columns are too narrow to accommodate the entry that you typed. In the next section, you'll look at how to fix this issue using formatting techniques.  
 
    [image: Cell C2 activated with "Average Price" in formula displayed as "Average P" in cell due to narrow column.] 
 
    Entering Column Headings in a Worksheet  
 
    Column Headings  
 
    Column headings that correctly define the data inside a column of the worksheet are important. You'll almost certainly be sharing Excel workbooks among colleagues in a professional environment. Effective column headings minimize the risk of anyone misinterpreting the details in the worksheet, which could result in serious or even career-threatening mistakes.  
 
    
    	 Click cell B3.  
 
    	 Click the ENTER key, then type the number 2670. Cell B4 is activated after you click the ENTER key. Entering data down through a column with the ENTER key is a quick and productive method.  
 
    	 Enter the numbers 2160, 515, 1180, 1800, 590, 1030, 900, 775, 2875, 2700, and 3560 into cells B4 to B14.  
 
    	 Click cell C3.  
 
    	 Click the ENTER key after typing the number 9.99.  
 
    	 In cells C4 and C14, type 12.49, 14.99, 19.99, 17.49, 17.49, 14.99, 19.99, 9.99, 19.99, 19.99, 12.49, and 14.99.  
 
    	 Activate cell D3.  
 
    	 Click the ENTER key, then type the number 26685.  
 
    	 Enter the numbers 26937, 7701, 23562, 31416, 10269, 15405, 17958, 15708, 35916, 26937, and 53370 into cells D4 to D14.  
 
   
 
    When you've finished, double-check that the information you entered corresponds to Figure 
 
    Hint and Tips 
 
    While entering numbers, don't use symbols to format them.  
 
    It’s safe not to use coding symbols like dollar signs and commas while entering numbers into an Excel worksheet. While you can incorporate these symbols when typing numbers in Excel, it delays the data entry operation. It's easier to apply these symbols to numbers after they've been typed into the worksheet using the formatting features of Excel.  
 
    Data Entry  
 
    It's critical to thoroughly proofread any worksheet, particularly if you've entered numbers. When manually inserting data into the worksheet, it's normal to transpose numbers. A number 563, for example, maybe changed to 536. Such mistakes will jeopardize the credibility of your workbook.  
 
    Figure 1.16 depicts how the worksheet might look after you've entered your data. Please ensure the numbers are entered correctly in your worksheet by double-checking them.  
 
    [image: Numbers have been entered into columns B, C, and D without symbols such as dollar signs or commas.] 
 
    Completed Data Entry for Columns B, C, and D  
 
    Editing Data  
 
    Double-clicking a cell position using your Formula Bar will adjust the data inserted in it. You may have seen that the data was typed into the cell position as shown in the Formula Bar when you typed it. The Formula Bar can be used to insert data in cells and modify data that has already been entered. The stages below demonstrate how to enter and then edit data that has been inserted into a cell position:  
 
    
    	 On Sheet 1 of your worksheet, click on cell A15.  
 
    	 Click ENTER key after typing the abbreviation “Tot.”  
 
    	 Cell A15 should be selected.  
 
    	 Move the mouse pointer up to the Formula Bar. The pointer will change into the cursor. Left-click here on the abbreviation “Tot” after moving the mouse to the last letter.  
 
    	 To conclude the term Total, type the letters “al.”  
 
    	 Click on the checkmark to the left of the Formula Bar. The modification is then made in the cell. 
 
   
 
    [image: Checkmark left of formula bar is highlighted and "Total" is typed in formula bar. "Total" appears in active cell A15.] 
 
    Using the Formula Bar to Edit and Enter Data  
 
    
    	 Double-click cell A15.  
 
    	 After the word Total, type the word Sales with a space between the two words.  
 
    	 To begin, press the ENTER key.  
 
   
 
    Keyboard Shortcuts  
 
    Editing Data in a Cell  
 
    To edit a cell, activate it and press the F2 button on the keyboard.  
 
    [image: Column A width increased, Row 15 height increased to create space between totals and rest of data.] 
 
    Hiding Columns and Rows  
 
    You can hide rows and columns on a worksheet in addition to changing rows and columns. This is a helpful strategy for improving the graphic presentation of your worksheet with data that doesn’t need to be displayed. The workbook containing Data on GMW Sales is used to illustrate these capabilities. This worksheet, however, does not include concealed rows or columns. These skills are only used for presentation purposes here.  
 
    
    	 By hovering the mouse cursor over cell C1 in the worksheet Sheet1 and tapping the left mouse key, you will access it.  
 
    	 In the Ribbon Home tab, click the Format button.  
 
    	 In the drop-down menu, hover the mouse cursor over the Hide and Unhide options. This will reveal a drop-down menu of options.  
 
    	 In your submenu of options, select Hide Columns. This will make Column C invisible.  
 
   
 
    [image: Hide & Unhide drop-down menu with commands for hiding and showing rows, columns, and worksheets.]  
 
    Hiding Columns 
 
    While pressing the number 0 on the keyboard, hold down your CTRL-key.  
 
    The workbook has hidden column C in your Sheet1 worksheet. The absence of the letter C indicates that this column is concealed.  
 
    [image: Columns A, B, then D, indicating column C is hidden.] 
 
    Hidden Column  
 
    Follow these steps to unhide the column:  
 
    
    	 By clicking on and holding cell B1 and dragging it into cell D1, you will highlight the B1:D1 range.  
 
    	 On the Ribbon Home tab, click on the Format icon.  
 
    	 In the drop-down menu, hover your mouse over the Hide and Unhide options.  
 
    	 Unhide columns can be found in the sub-menu of options. On your worksheet, column C is then visible again. 
 
   
 
    Keyboard Shortcuts  
 
    Unhiding Columns  
 
    Hold down your CTRL and SHIFT keys while pressing the “open” parenthesis key “(”on the keyboard to highlight the cells on each side of a hidden column.  
 
    The measures below explain how you can hide rows in the same way as you can hide columns:  
 
    
    	 By hovering the mouse cursor over cell A3 in your Sheet1 worksheet and pressing the left mouse key, you will access it.  
 
    	 In the Ribbon Home tab, click on the Format key.  
 
    	 In the drop-down menu, hover the mouse cursor over the Hide and Unhide options. This will reveal a drop-down screen of options.  
 
    	 Hide Rows can be found in the sub-menu of the new list of options. This would make Row 3 invisible.  
 
   
 
    Keyboard Shortcuts  
 
    Hiding Rows  
 
    When pressing the number 9 on the keyboard, hold down the CTRL-key.  
 
    Follow these steps to unhide the row:  
 
    
    	 By clicking on and holding cell A2 and dragging it to cell A4, the A2:A4 range is highlighted.  
 
    	 On the Ribbon Home tab, click on the Format key.  
 
    	 In the drop-down menu, hover your mouse over the Hide and Unhide options.  
 
    	 Unhide Rows can be found under the Options submenu. On your worksheet, Row 3 will now be visible again. 
 
   
 
    Keyboard Shortcuts  
 
    Unhiding Rows  
 
    Hold down your CTRL and SHIFT keys when clicking the open parenthesis key “(” on the keyboard to highlight the cells above and below the hidden row(s).  
 
    Integrity Check  
 
    Hidden Rows and Columns  
 
    In most professions, it is common for employees to use Excel workbooks created by coworkers. Often check for hidden columns and rows when using a workbook created by others. If a column letter or row number is absent, you will easily see if a column or row has been hidden.  
 
    Skill Refresher  
 
    Hiding Columns and Rows  
 
    
    	 Activate a minimum of one cell in hidden column(s) or row(s).  
 
    	 Select the Ribbon Home tab.  
 
    	 In the group of cells, click on the Format button.  
 
    	 Place your cursor over the Hiding and Unhide options.  
 
    	 Select Hide Columns or Hide Rows from the drop-down menu.  
 
   
 
    Skill Refresher  
 
    Unhiding Columns and Rows  
 
    
    	 Cells above and below the hidden row(s) or to the left and right of a hidden column are highlighted (s).  
 
    	 Select the Ribbon Home tab.  
 
    	 In the cells group, click on the Format key.  
 
    	 Place the cursor over the Hide and Unhide options.  
 
    	 Select Unhide Columns or Unhide Rows from the drop-down menu.  
 
   
 
    Moving Data  
 
    You might want to transfer data in a worksheet to various positions after it has been entered. The measures below explain how to transfer data from one location on the worksheet to another:  
 
    
    	 By activating cell D2 and dragging it down to cell D15, you will highlight the D2:D15 range.  
 
    	 Bring your mouse cursor to the left of cell D2. You can see a white block plus symbol change to crossed arrows. This means you can left-click the data and move it to a new location. 
 
   
 
    [image: Column D selected with cross arrows on left indicating that data is ready to be moved.] 
 
    Moving Data  
 
    
    	 Click the left mouse key on cell C2 and move the mouse cursor.  
 
    	 Release your left mouse key. Column C now contains the details.  
 
    	 Using the Quick Access Toolbar, click the Undo button. This returns the data to Column D.  
 
   
 
    When you move data around on a worksheet, double-check that you've identified all the components related to the sequence you're transferring.   
 
    If you're transferring a column of information, for instance, ensure that the column heading has been included. Before moving a list, double-check that the values you need are illuminated.  
 
   

 

 Create and Manage Workbooks  
 
    To Make a New Blank Workbook 
 
    
    	 Click on the File tab. A backstage view will be displayed. 
 
   
 
    [image: Click the File tab to go to the Backstage view.] 
 
    
    	 Choose New, then select Blank Workbook. 
 
   
 
    [image: Image] 
 
    
    	 You'll see a new blank workbook appear. 
 
   
 
    To Access a Previously Saved Workbook 
 
    You'll frequently need to open a previously saved workbook in addition to making new workbooks. To do this follow the steps below. 
 
    
    	 Go to Backstage view and select Open. 
 
   
 
    [image: Open in the Backstage view] 
 
    
    	 Click Browse. You can also select OneDrive to access files saved on your OneDrive account. 
 
   
 
    [image: Browse] 
 
    
    	 The dialog box “Open” will appear. Click Open after you've found and selected your workbook. 
 
   
 
    [image: The Open dialog] 
 
    
    	 Instead of searching for the file, browse your Recent Workbooks if you've recently opened the required workbook. 
 
   
 
    [image: Open a recent workbook] 
 
    To Pin a Workbook 
 
    You can pin a workbook to a Backstage view for easier access if you work with it frequently. 
 
    
    	 Go to Backstage view and select Open. Workbooks that you've recently edited will appear. 
 
   
 
    [image: Navigate to recently edited workbooks] 
 
    
    	 Place your mouse over the workbook you'd like to pin. Next to the workbook, a pushpin icon will appear. Click the pushpin icon. 
 
   
 
    [image: Pin a recent workbook] 
 
    
    	 The workbook will be saved in the Recent Workbooks section. Simply click the pushpin icon again to unpin a workbook. 
 
   
 
   

 

 File Extensions or Types   
 
    XLS  
 
    It is the most common file extension; this is the default extension for spreadsheets produced by Microsoft Office. This extension was widely used during MS Office versions before 2k7.  
 
    XLSX  
 
    Spreadsheet files generated with Excel version 2k7 use this file extension. XLSX is the current and most recent default extension for such an Excel file.  
 
    XLSM  
 
    This extension is created using an Excel 2k7 system. Excel macros are included in this category. With the aid of extension, you can quickly determine if a file contains macros.  
 
    XLSB   
 
    If your excel files contain a large amount of data or information, this file extension will help you by first compressing, then saving, and opening them quickly.  
 
    XLTX  
 
    An Excel file is kept as a template that can use to create new Excel workbooks.   
 
    XLTM  
 
    An Excel file with macros that are stored as a template.  
 
    How Can One Figure Out the Extension Within an Excel File?  
 
    
    	 Choose any file you would want to look up the extension for.  
 
    	 Just right-click the File.  
 
    	 Displays a drop-down menu of options.  
 
    	 From the drop-down menu, choose Properties. Please see the image below for more information.  
 
   
 
    [image: A pinned workbook] 
 
    

  

 

 Chapter 4. Excel Worksheet Operations 
 
      
 
   

 

 Inserting Columns and Rows  
 
    Using pre-made Excel workbooks is a time-saving method of working since it removes the need to build data worksheets from scratch. However, you will discover that you may have to add further rows or columns of data to achieve your objectives. In this scenario, you need to build a worksheet with blank rows or columns. The steps below explain how to do this:  
 
    
    	 By hovering the mouse cursor over cell C1 in your Sheet1 worksheet and pressing the left mouse key, you can access it.  
 
    	 In the Ribbon Home tab, click the down arrow on the Insert icon.  
 
   
 
    [image: 00023.jpeg] 
 
    Insert Button  
 
    From the drop-down menu, select Insert Sheet Columns. To the left of Column C, a vacant column has been included.   
 
    Column D also contains the details that were originally in Column C. It's worth noting that columns often are placed to the left of an active cell.  
 
    [image: Insert button drop-down menu for inserting cells, rows, columns or sheets.]  
 
    Insert Drop-Down Menu   
 
    Keyboard Shortcuts  
 
    Inserting Columns  
 
    
    	 After holding your ALT key, press the letters I, H, and C at once. Another column is added to the left of the active cell.  
 
    	 By hovering the mouse cursor over cell A3 in your Sheet1 worksheet and pressing your left mouse key, you will access it.  
 
    	 In the Ribbon Home tab, click the down arrow until you reach the Insert key.  
 
    	 From the drop-down menu, select Insert Sheet Rows. Over Row 3, a vacant row has been added. Row 4 also contains the details that were originally in Row 3. It's worth noting that rows are often placed over an active cell.  
 
   
 
    Keyboard Shortcuts  
 
    Inserting Rows  
 
    Holding the ALT key, press letters I, H, and R together. A row is added above the active cell.  
 
    Skill Refresher  
 
    Inserting Columns and Rows  
 
    
    	 Activate any cell to the right of or below the required blank row or column.  
 
    	 Select the Ribbon Home tab.  
 
    	 In the group of cells, click the down arrow until you reach the Insert button.  
 
    	 Select either Insert Sheet Row or Insert Sheet Column from the drop-down menu.  
 
   
 
   

 

 Deleting Columns and Rows  
 
    You may need to erase whole rows and columns of content from a worksheet. This might be needed if you want to delete blank rows or columns from the worksheet or data-filled columns and rows. A method for extracting cell data was previously discussed and this can be utilized to remove unnecessary information. If you don't want a vacant column or row in the workbook, you can remove it by following the steps below:  
 
    
    	 By hovering the mouse cursor over cell A3 and pressing the left key, you can access it.  
 
    	 In the Ribbon Home tab, click the down arrow until you reach the Delete button in the group of cells.  
 
    	 From the drop-down menu, choose Delete Sheet Row. Row 3 is removed and all data within the worksheet is shifted up one row.  
 
   
 
    Keyboard Shortcuts  
 
    Deleting Rows  
 
    
    	 Hold the ALT key, then press letters D, H, and R together. The row in which the active cell is located is removed.  
 
   
 
    [image: Delete button drop-down menu for deleting cells, rows, columns and sheets.]  
 
    Delete Drop-down Menu  
 
    
    	 By hovering the mouse cursor over cell C1 and pressing the left button, you can access it.  
 
    	 In the Ribbon Home tab, click the down arrow until you reach the Delete button in the group of cells.  
 
    	 From the drop-down menu, choose Delete Sheet Column. Column C is removed and all the content in your worksheet is shifted one column to the left.  
 
    	 Save your workbook modifications by pressing the Save icon on your Home ribbon or, alternatively, choosing the Save from your File menu.  
 
   
 
    Keyboard Shortcuts  
 
    Deleting Columns  
 
    Hold down the ALT key, and press the letters D, H, and C together. The column in which the active cell is located is removed.  
 
   

 

 Clear a Cell’s Contents  
 
    To clear a cell content;  
 
    
    	 Select the cell(s) and press the Delete key.  
 
    	 Or, click the Clear button on the Home tab and select Clear. 
 
   
 
   

 

 Cut or Copy Data  
 
    Select the cell (s) and snap the Cut or Copy button on the Home tab.  
 
   

 

 Preview an Item Before Pasting   
 
    Microsoft Excel 2021 has the outstanding feature to easily paste any of the items from the clipboard without the need to copy and paste.  
 
    To quickly preview an item before pasting:  
 
    
    	 Step 1. Select the text/cells which need to be displayed in the spreadsheet.  
 
    	 Step 2. Right-click on the cell/s that contain the items and click on “Paste Special.” A dialog box will pop up, asking whether the selected items need to be displayed in the spreadsheet.  
 
    	 Step 3. Click on Yes.  
 
   
 
    You will notice that the values will automatically appear in the spreadsheet. If you need the other spreadsheet to be displayed, just click on “Paste and Match Style.” This will then display the entire column in the desired spreadsheet.  
 
   

 

 Paste Special  
 
    This feature is a great tool to move a selected cell into another cell in a different location. To use this feature, you need to do the following steps.  
 
    
    	 First, select the cell where you want to paste the data.  
 
    	 Second, right-click on that cell and select “Paste Special.” The next window will appear on your screen. This is a list of options for Paste. Now choose the option Paste Special.  
 
   
 
   

 

 Settings for Formulas  
 
    You can use this option to monitor how Excel acts when working with formulas. It can be used to configure options such as autocomplete when inserting formulas, changing the cell referencing type, and using numbers for both rows and columns, among other things.  
 
    [image: Microsoft Excel Tutorial] 
 
    To make a choice active, check the box next to it. Remove the checkmark from the checkbox to deactivate an option. This option is available in the Options dialogue box, under the Formulas tab on the left-hand side column.  
 
   

 

 Auto Fill  
 
    When manually inserting data into a worksheet, the AutoFill function comes in handy. This function is useful for various things, but it's especially useful when entering data in a certain order, like the numbers 1, 3, 5, 7, and so forth. It can even be used with non-numeric data like days of the week or months of the year. The stages below explain how to use AutoFill to add certain months of a year in Column A:  
 
    
    	 On the Sheet1 worksheet, click cell A3.  
 
    	 Click the ENTER key after typing the word “January.”  
 
    	 Activate cell A3 again.  
 
    	 Move your mouse cursor to the bottom right corner of cell A3. In the corner of the cell, you'll see a tiny square called a Fill Handle. The white plus sign of the block will transform into a black plus sign as the mouse cursor approaches the Fill Handle.  
 
   
 
    [image: Cell A3 is activated with "January" entered. Fill handle is shown at bottom right corner of cell.] 
 
    Drag the Fill Handle to cell A14 with the left mouse button. An AutoFill tips box specifies which month will be entered into every cell. When the tip box displays “December,” remove your left mouse button.  
 
    [image: Cells A3 through A14 highlighted using Fill Handle (black plus sign). "December" in tip box indicates that word will be entered into cell A14.] 
 
    If you release your left mouse key, all 12 months of the year appear throughout the cell ranges A3:A14. An Auto Fill Options icon is also visible. You have many choices for inserting data into a collection of cells when you use this icon.  
 
    [image: 12 months appear in cell range A3:A14. Auto Fill Options Button includes Copy Cells, Fill Series, Fill Formatting Only, Fill Without Formatting and Fill Months.] 
 
    Auto Fill Options Button  
 
    
    	 Select Auto-Fill Options from the drop-down menu.  
 
    	 Select Copy Cells from the drop-down menu. The months into the range A4: A14 will then change to January.  
 
    	 Click on the Auto-Fill Options tab again.  
 
    	 To restore all months of the year to the cell range A4: A14, select the Fill Months option. Choosing Fill Series achieves the same outcome.  
 
   
 
   

 

 Deleting Data and the Undo Command 
 
    There are a few strategies for removing data from a worksheet, and you'll explore some of them here. You can also use the Undo command for each process.   
 
    This is a really useful command if you accidentally delete data from a worksheet. The stages below illustrate how to erase data from a cell or group of cells:  
 
    
    	 Place the mouse cursor over cell C2 and press the left mouse key to select it.  
 
    	 On the keyboard, press the DELETE key. The information in the cell is removed with this action.  
 
    	 Place the mouse cursor on cell C3 to highlight the group of cells C3: C14. Then, holding the left mouse button, drag down to the C14 cell.  
 
    	 Place your cursor over the Fill Handle. A white block plus sign will be replaced by a black plus sign.  
 
    	 Move up to cell C3, and click and drag your mouse cursor. Release the mouse key. The contents of the C3: C14 cell range will be erased.  
 
   
 
    [image: Fill Handle dragged up from cell C14 to cell C3 highlighting data in these cells will be deleted. Undo button top left of Home ribbon.] 
 
    
    	 In the Quick Access Toolbar, click the Undo button. This should replace the data back into the C3:C14 range.  
 
    	 Click the Undo button again. This should replace the information in the C2 cell.  
 
   
 
    Keyboard Shortcuts  
 
    Command Undo 
 
    
    	 When pressing the letter Z on the keyboard, hold down your CTRL-key.  
 
    	 Place the mouse cursor over cell C2 to highlight the C2:C14 range. Then, holding the left mouse button, drag the cursor down to cell C14.  
 
    	 In the Ribbon Home tab, next to the Cells group of the commands, click on the Clear button. This shows the drop-down menu with several choices for clearing or deleting data from a cell. You can also choose to clear the format of a cell or all hyperlinks in a cell.  
 
    	 Select the option to Clear Everything. This clears the data from the selected cell set.  
 
    	 To undo a change, press the Undo key. This replaces the data throughout the C2:C14 range.  
 
   
 
    [image: Clear button and Clear Command drop-down menu: Clear All, Formats, Contents, Comments, Hyperlinks and Remove Hyperlinks.] 
 
   

 

 Adjusting Columns and Rows  
 
    Some entries in your worksheet happen to be missing. In cell A11, for instance, the final letter of the word “September” is not visible. This is because the column is small for this expression. The columns and rows of the Excel worksheet can be rearranged to suit the data being entered into a cell. The instructions below will illustrate how to configure both column widths and row heights in a worksheet.  
 
    
    	 In the worksheet named Sheet1, slide the mouse cursor between Column A and Column B. A white block plus sign transforms into double arrows.  
 
    	 To see the whole word “September” in the A11 cell, click and move the column to the right. The column width tip box will appear as you move the column. The character's number would fit into the column using Calibri 11-point font, which is the default font/size configuration and is shown in this box.  
 
    	 Release the left mouse key.  
 
   
 
     [image: Column A and Column B with double arrows on column border between them. Column width tip box indicates width of column, wide enough now to show whole word "September".] 
 
    If you want to set the width of a specific character for one or more columns, you will notice that the click-and-drag approach is inefficient. By utilizing a certain number of characters, the following steps 1 through 6 demonstrate a second approach to change the column widths:  
 
    
    	 By sliding the mouse cursor over the cell position and pressing the left mouse key, you can choose every cell location in Column A. If you want to set a similar character width for more than one column, you can highlight the locations of cells in many columns.  
 
    	 Left-click the Format button in the group of cells on the Ribbon Home tab.  
 
    	 From the drop-down menu, select the Column Width option. The Column Width dialog box will appear.  
 
    	 In the Column Width dialog box, type “13” and press the OK icon. This sets the character width in Column A to this value.  
 
    	 Bring your mouse cursor back between Columns A and B until a double arrow cursor appears; the double arrow is displayed when activating AutoFit. The column width is adjusted depending on the maximum entry set for the column.  
 
    	 Reset the column width to 13 using the Width of the Column dialog box (use step 6 earlier in this thread).  
 
   
 
    [image: Cell A11 "September" activated and Column Width dialog box opened with "13" entered, the max number of characters to fit in that cell.] 
 
    Keyboard Shortcuts  
 
    Column Width  
 
    Click the ALT key, then type the letters O, H, and W once on the keyboard.  
 
    Steps 1–4 explain how to change the height of a row, which is equivalent to changing the width of a column:  
 
    
    	 Place the mouse cursor over cell A15 and press the left mouse key to select it.  
 
    	 Left-click on the Format button of the group of cells on the Ribbon Home tab.  
 
    	 From the drop-down menu, select the Row Height option. The Row Height dialog box will appear.  
 
    	 Inside this Row Height dialog box, type 24 and press the OK icon. Row 15 will now have a height of 24 points. Each point is roughly 1/72 of an inch in size. This change in row height was created to make room between the worksheet's totals and the remainder of the results. 
 
   
 
    Keyboard Shortcuts  
 
    Row Height  
 
    Click the ALT key, then the letters O, H, and H once on the keyboard.  
 
   

 

 Filtering  
 
    If you just want to see documents that show certain data, you can use the Excel filter function.  
 
    
    	 Choose every cell in a collection of data by clicking it.  
 
    	 Choose Filter from the Sort and Filter group on the Data page.  
 
   
 
    [image: Filter Example] 
 
    The column headers have arrows in them.  
 
    [image: Filter Arrrows] 
 
    
    	 Choose a country (the USA) by clicking the arrow beside it.  
 
    	 To remove all the checkboxes, press Select All, then click the check box beside the USA.  
 
   
 
    [image: Click USA] 
 
    
    	 Click the OK button.  
 
   
 
    As a result, Excel just shows revenue in the United States.  
 
    [image: Filter in Excel] 
 
    
    	 Choose Quarter by clicking the arrow beside it.  
 
    	 To remove all the checkboxes, press Select All, then click the check box beside Qtr. 4.  
 
   
 
    [image: Click Qtr 4] 
 
    
    	 Click the OK button.  
 
   
 
    As a result, Excel just shows the revenue for Qtr. 4 in the United States.  
 
    [image: Filter in Excel] 
 
    
    	 On the data page, press Clear to delete the filter in the Sort and Filter group. Select Filter to delete the filter and the arrows.  
 
   
 
    [image: Clear Filter] 
 
    Filtering Excel data can be done more quickly.  
 
    
    	                      Choose one cell.  
 
   
 
    [image: Filter by Selection] 
 
    
    	                      Choose Filter, then Filter by Value of Selected Cell from the options by right-clicking.  
 
   
 
    [image: Filter by Selected Cell's Value] 
 
    As a result, Excel just shows revenue in the United States.  
 
    [image: Filtered Data] 
 
    To further sort this data collection, simply pick another cell from another column.  
 
   

 

 Find and Replace 
 
    When dealing with a massive proportion of data in Excel, finding specific information can be challenging and time-consuming. You can use the Find feature to quickly browse your workbook, and you can also use the Replace feature to change the content. 
 
    To Find Content 
 
    
    	 Click the Find and Choose command on the Home page, then pick Find. from the dropdown list.  
 
   
 
    [image: 00062.jpg] 
 
    
    	 The dialogue box for Find and Replace will appear. Enter the content you're looking for.  
 
    	 Choose Next from the Find menu. If the data is found, the cell that contains it would be selected.  
 
   
 
    [image: 00063.jpg] 
 
    
    	 Select Find Next to find more instances of the search term or Find all to display all instances of the search term.  
 
    	 To close the Find and Replace dialogue box, select Close when you're done.  
 
   
 
    Note: You can also use your keyboard to access the Find command by pressing Ctrl+F. 
 
    Note: In the Find and Replace dialogue box, click Options to display advanced search criteria. 
 
    [image: 00064.jpg] 
 
    To Replace Cell Content 
 
    You might find that you've made an error repeatedly in your workbook (for example, misspelling someone's name), either that you need to substitute a term or expression for another. To make swift changes, use Excel's Find and Replace feature. 
 
    
    	 Select Replace from the dropdown menu after clicking the Find and Choose command on the Home page.  
 
    	 A dialogue box called Find and Replace will open. In the Find what: field, type the text you're looking for.  
 
    	 In the Replace with the field, type the text you want to replace it with, then select Next.  
 
    	 If the content is detected, the cell holding it is chosen.  
 
    	 Double-check if you want to replace the text.  
 
    	 Choose one of the replace choices if you want to replace it:  
 
   
 
    
    	 Replace would replace individual instances.  
 
    	 Replace every instance of the text in the workbook by Replace All.  
 
   
 
    
    	 A dialogue box will open, confirming the number of replacements that have been performed. To proceed, click OK.  
 
    	 To close the Find and Replace dialogue window, press Close when you're done.  
 
   
 
   

 

 Sorting 
 
    To quickly sort, select your Sort Z to A/A to Z symbols within Sort and Filter set of the Data menu by clicking the arrow just under your Sort and Filtering symbol in the Editing set of the Home panel. Sort smallest to the largest and vice versa in Excel 2013.  
 
    [image: D:\excel book 2\iamges revision\8.JPG] 
 
    To do a more sophisticated sort, go over to the Home menu and select Custom Sort from the Editing group's arrow just below the Filter and Sort and button. This opens the Sort dialogue box that appears when you click the Sort symbol within the Sort and Filter category of its Data ribbon.  
 
    [image: D:\excel book 2\2b.JPG] 
 
    
    	 Select the first column to sort from the Column drop-down menu. Tap the Add Level icon if you wish to sort several columns.  
 
    	 Select how you want to sort under Sort On. In addition to data, Excel also sorts by cell and font color.  
 
    	 Select Z to A (descending), A to Z (ascending), or Custom List under Order.  
 
    	 To complete the sort, press OK.  
 
   
 
   

 

 How to Remove Duplicates? 
 
    To quickly detect and delete duplicate documents from a registry, use Excel's Exclude Duplicates function (or rows from a table). This is a great function, mainly if you're working with a vast data set that needs to be entered by many individuals and shouldn't have the duplicated documents (such as lists of clients and any personnel files or other similar things). Take these basic measures to make Excel delete any redundant copies from a data list or table: 
 
    
    	 Place the cell pointer anywhere in one cell of your data lists or table's cells. 
 
    	 Press Alt+AM or click the Delete Duplicates order on the Data tab of the Ribbon. 
 
    	 Excel selects all of the cells in the data list and displays the Remove Duplicates dialogue box, which looks like the one in Figure below. 
 
   
 
    
    	 When you first open this dialogue box, Excel immediately picks all of the fields in the set (by placing checkmarks in the checkboxes in front of their names in the Columns list box). 
 
    	 When you pick all of the fields in this dialogue box and press OK, Excel deletes just real duplicates (or copies) of the records in the list. Erase the checkboxes from all the columns except those where repetition is reasonable for removing the whole document if you need the software to remove records, where there is some overlap of entries in specific fields (such as the ID No field) (as described in Step 3). a good enough excuse to delete the whole record (as defined in Step 3). 
 
    	 Suppose you're looking for an Option. Remove the checkmarks from all of the fields in the Columns collection box, excluding those that are duplicates that should be deleted. 
 
    	 If only one or two fields out of several need to be picked in the Columns list box, use the Unselect All button to clear the checkmarks from all field checkboxes and then press the fields that can't duplicate entries individually. 
 
    	 To close the Delete Duplicates dialogue box and remove the duplication (rows) from the specified data set, click OK. 
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 Cutting, Copying, and Pasting Cells  
 
    To switch cells from one spot on a worksheet to another, first copy or cut the cell(s), then paste the cell or cells in their current location.  
 
    To cut a cell, do the following:  
 
    
    	 To select a cell, click it.  
 
    	 Choose the Home tab from the drop-down menu.  
 
    	 Press Ctrl + X on your screen or click on the Cut button in the Clipboard cluster.  
 
   
 
    [image: Cut Button] 
 
    To copy a cell, do the following:  
 
    
    	 To choose a cell, click it.  
 
    	 Choose the Home tab from the drop-down menu.  
 
    	 Press Ctrl + C on your screen or click the Copy button in the Clipboard cluster.  
 
   
 
    [image: Copy Button] 
 
    To paste a cut or copied cell to a new location on your worksheet, do the following:  
 
    
    	 To find a new location on your worksheet, click it.  
 
    	 Choose the Home tab from the drop-down menu.  
 
    	 Press Ctrl + V on the keyboard or click the Paste button in the Clipboard group.  
 
   
 
   

 

 Formulas and Functions 
 
    The ability to determine numerical values using formulas is one of Excel's most essential functions. Working with Excel Formulas will take the experience of the software to a new level. Excel is designed on a base of formulas. In your workbooks, formulas are used to measure cells, numbers, and other data. Built-in algorithms (usually in the form of prefixes) are inserted into formulas to conduct a number of calculations. 
 
    Simple Formulas 
 
    Excel can subtract, add, divide, and multiply like a calculator. If you're new to Excel, creating formulas is one of the first tasks you can learn. This book will show you how to create basic Excel formulas and calculations and how to create simple formulas using cell references. At its core, Excel is a massive calculator. Treating each cell in a worksheet as a single calculator is a simple way of thinking about Excel. Since an Excel table has millions of cells, you have to deal with millions of different computers. You can even make formulas that link various cells (e.g., apply value to the cell number). In different worksheets, you can create formulas that connect cells. In addition, you can create formulas in different workbooks that connect cells. 
 
    Mathematical Operators 
 
    For formulas, Excel uses regular operators such as the plus sign (+), a forward slash for division (/), the minus sign (-), an asterisk for multiplication (*), and a caret (^) for exponents. 
 
    [image: 00093.jpg] 
 
    In Excel, all formulas should start with an equal sign (=). This is because the formula and the result or value it determines are included in, or equivalent to, the cell. 
 
    Understanding Cell References 
 
    You can manually generate basic formulas in Excel (e.g., =2+2 or =5*5); most formulas are created using cell addresses. Also called making a cell reference. Since you can adjust the value of referenced cells despite needing to rewrite the calculation, using cell references ensures that the formulas are always accurate. 
 
    [image: 00094.jpg] 
 
    In Excel, you can generate a number of basic formulas by integrating a mathematical operator into cell references. As seen in the examples below, formulas may also provide a variety of cell references with numbers: 
 
    [image: 00095.jpg] 
 
    To Create a Formula 
 
    
    	 Choose the cell where the formula will be entered.  
 
    	 Type the equals symbol (=) in the cell. Take note of how it appears in the cell as well as the formula bar.  
 
    	 In the formula, type the cell address of the cell you want to reference first.  
 
    	 A blue border will surround the referenced cell.  
 
    	 Enter the mathematical operator you want to use.  
 
    	 In the formula, type the cell address of the cell you want to reference second. A red border will surround the referenced cell.  
 
    	 On your keyboard, press Enter. The value of the formula will be expressed in the cell after it has been calculated.  
 
   
 
    Note: If a formula's outcome is too large to fit in a cell, it will display as pound signs (#######) rather than a value. This indicates that the column is too narrow to represent the contents of the cell. To see the cell content, simply increase the column width. 
 
    Modifying Values With Cell References 
 
    Cell references have the distinct benefit of allowing you to update content in your worksheet without attempting to rewrite formulas. 
 
    Tip: Since Excel does not often warn you whether a formula has an error, you must double-check all of the formulas. 
 
    To Create a Formula Using the Point-and-Click Method 
 
    Instead of manually entering cell addresses, you can simply point and click on the cells you want to use in your formula. When creating formulas, this approach will save a lot of time and effort. A formula is developed in the example below to determine the cost of buying several boxes of plastic silverware. 
 
    
    	 Choose the cell where the formula will be entered. Cell D3 is selected in this case.  
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    	 First, Type the equals sign (=) 
 
    	 In the current case, choose cell B3 as the first cell to reference in the method. A dotted blue line will appear across the referenced cell, and the cell address will show in the formula.  
 
   
 
    [image: 00097.jpg] 
 
    
    	 Enter the mathematical operator you choose to use. The multiplying sign (*) has been typed in this case.  
 
    	 In the current case, choose cell C3 as the second cell to reference in the formula. A dotted red line will appear across the referenced cell, and the cell address will appear in the formula.  
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    	 On the keyboard, press Enter. The value of the formula will be shown in the cell after it has been calculated.  
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    With the fill handle, you can copy formulas to adjacent cells, which can save you a lot of time and effort if you still need to do the same calculation several times in a worksheet. 
 
    To Edit a Formula 
 
    It's possible that you'll want to change a current formula at some point. In the example below, you'll need to fix an incorrect cell address in the formula. 
 
    
    	 Choose the cell that contains the formula you want to change.  
 
    	 To edit the formula, click the formula bar. You may also open and edit the formula directly in the cell by double-clicking it.  
 
    	 A border will accompany any referenced cells.  
 
    	 Press Enter on the keyboard or click the Enter command in the formula bar when you're done.  
 
    	 The formula will be changed, and the new value in the cell will be shown.  
 
   
 
    Note: If you change your mind, you can cancel your formula by pressing the Esc key on your keyboard or clicking the Cancel command in the formula bar. You should hold the Ctrl key and click to see any of the formulas in a spreadsheet (grave accent). The grave accent key is usually found in the keyboard's upper-left corner. You will return to the standard view by pressing Ctrl+ again. 
 
    Complex Formulas 
 
    A simple formula, such as 7+9, is a mathematical equation with just one operator. A complicated formula, such as 5+2*8, has more than one logical operator. When a calculation contains several operations, the sequence of operations informs Excel which one to calculate first. You must consider the sequence of operations to use Excel to measure complicated formulas. 
 
    Order of Operations 
 
    The below is the sequence in which Excel calculates formulas: 
 
    
    	 Parenthetical operations are those that have parentheses around them.  
 
    	 Exponential equations (for instance, 3^2)  
 
    	 Division and multiplication, whichever falls first,  
 
    	 Whichever comes first, addition and subtraction  
 
   
 
    Creating Complex Formulas 
 
    You'll notice how Excel calculates a complex formula using the sequence of operations in the example below. You must measure the cost of sales tax on an invoice in this example. In cell D4, write the formula =(D2+D3) *0.075 to achieve this. To measure the sales tax cost, multiply the total price of all goods by the 7.5% tax rate (which is written as 0.075). 
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    Note: Entering complicated formulas in the correct sequence of operations is particularly necessary. Excel cannot measure the outcomes correctly if this is not done. If the parentheses are not used in this case, the multiplication is done first, and the result is wrong. The easiest way to specify which Excel calculations will be done first is to use parentheses. 
 
    Functions 
 
    A function is a formula that conducts calculations of specific values in a predetermined sequence. Excel has a number of valuable functions for efficiently calculating the average, sum, count, maximum, and minimum value for a range of cells. You'll need to know the various aspects of a function and construct arguments to determine values and cell references to use functions correctly. 
 
    The Parts of a Function 
 
    A function should be described in a specific way to operate correctly, known as syntax. An equal sign, the name of the function (for example, SUM), and arguments are the simple syntax for a function. The detail that is required to determine is included in the arguments. 
 
    Working With Arguments 
 
    Arguments must be enclosed in parentheses and should refer to all individual cells and cell ranges. Depending on the syntax needed for the function, you can add one or more arguments. The function =AVERAGE(B1:B9), for example, calculates the average of values in the B1:B9 cell range. There is just one argument to this function. 
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    A comma must be used to distinguish several arguments. The following example adds the values of all the cells of three arguments. 
 
    [image: 00102.jpg] 
 
    Common Excel Functions 
 
    Excel offers a wide range of functions. Some of the commonly used functions are: 
 
    
    	 AVERAGE: Calculates the average of all the values in an argument. This Function equates the cells' sums, and by the number of cells in an argument result is divided.  
 
    	 SUM: sums up all of the values in the argument's cells.  
 
    	 COUNT: This function calculates the number of cells in the argument that contain numerical details. This function can be used to quickly count the number of items in a cell set.  
 
    	 MAX: This function returns the value of the largest cell in the argument.  
 
    	 MIN: This function returns the value of the lowest cell in the argument.  
 
    	 SUMIF: This function adds all the values in a range of cells that satisfy a set of parameters.  
 
   
 
    =SUMIF (range,criteria, [sum range]) =SUMIF (range,criteria, [sum range]) =SUMIF (range,  
 
    
    	 AVERAGEIF: Calculates the average value over the range of cells that follow the requirements. 
 
   
 
    =AVERAGEIF (range, criteria, [averagerange]) =AVERAGEIF (range,criteria, [average range]) =AVERAGEIF (range  
 
    
    	 DAYS: This function calculates the number of days between two dates.  
 
    	 NOW: Returns the latest date and time on the system.  
 
   
 
    To Create a Basic Function 
 
    A basic function has been developed using the AVERAGE function to measure the average price per unit to collect recently purchased goods. 
 
    
    	 Choose the cell where the function will be placed.  
 
    	 Type the equals sign (=) and the function name you choose to use. You may also select a function from a collection of suggested functions that appears when you type below the cell. Type =AVERAGE for this case.  
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    	 Inside parentheses, type the cell range for the argument. In this case, you'll need to type (D3:D12).  
 
    	 On the keyboard, press Enter. The function will be executed, and the output will be shown in the cell.  
 
   
 
    To Create a Function Using the AutoSum Command 
 
    The AutoSum command incorporates the most common functions, such as AVERAGE, SUM, MIN, COUNT, and MAX, into your formula automatically. A function has been created using the SUM function to measure the total cost for a list of recently purchased goods in the example below. 
 
    
    	 Choose the cell where the function will be placed.  
 
    	 Click the arrow next to the AutoSum command in the Editing group on the Home page and select the desired function from the drop-down list. Select Sum for this case.  
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    	 The cell will display the chosen function. The AutoSum command will choose a cell range for the argument if it is located logically. You can also type the required cell range into the argument manually.  
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    On the keyboard, press Enter. 
 
   

 

 The Function Library 
 
    Although Excel has hundreds of functions, the ones you use the most can be determined by the type of data in your workbooks. There's no need to master every single function, so getting a better understanding of the various forms of functions can help you develop new projects. From the Formulas tab's Function Library, you can search for functions by types, such as Logical, Financial, Date Text, and Time, and more. 
 
    Click the Formulas tab on the Ribbon to access the Function Library. The Function Library will now appear on the screen. 
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    	 The command Insert Function helps you browse for functions using keywords if you're having difficulty locating the correct one.  
 
    	 The AutoSum command returns results for basic functions like AVERAGE, SUM, and COUNT automatically.  
 
    	 The Recently Utilized command allows you to use functions that you've used recently.  
 
    	 The Financial category includes functions regarding financial calculations such as calculating a payment (PMT) or a loan's interest rate (RATE).  
 
    	 The Logical type includes functions that check claims for a value or state. For instance, if an order is over $50, add $4.99 for delivery; though, if the order is over $100, do not charge shipping (IF).  
 
    	 The Text type includes functions that execute tasks for text in arguments, such as replacing the text (REPLACE) or translating text to lowercase (LOWER).  
 
    	 The Date and Time-division includes functions for dealing with dates and times, such as the latest date and time (NOW) and seconds (SECOND).  
 
    	 The Lookup and Reference division includes functions that return information for searching and referring. You may apply a hyperlink to the cell or returns the value of the intersection of rows and columns (INDEX).  
 
    	 Functions for numerical statements are used in Math and Trig groups. You can, for example, round numbers, multiply subtotal, find Pi's value, etc.  
 
    	 More Functions includes additional functions in the Engineering, Statistical, Information, Cube, and Compatibility categories.  
 
   
 
    To Insert a Function From the Function Library 
 
    
    	 Choose the cell where the function will be located.  
 
    	 To access the Function Library, go to the Formulas tab on the Ribbon.  
 
    	 Select the desired function type from the Function Library group.  
 
    	 From the drop-down menu, choose the desired function.  
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    	 The Arguments for Functions dialogue box will appear. You can enter or assign the cells that will set up the arguments in the function from here.  
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    	 Click OK when you're done with the arguments.  
 
    	 The function would be operated, and the output will be shown in the cell.  
 
   
 
    Functions, like formulas, may be copied to nearby cells. Hover your cursor over the function cell, then press, hold, and move the fill handle over the cells you'd like to fill. The function will be duplicated, and the values for specific cells will be determined about their rows or columns. 
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    The Insert Function Command 
 
    If you're having difficulty locating the correct function, you can use the Insert Function command to check for it by keyword. This order, although incredibly helpful, can be a little challenging to use at times. You may have more chances searching the Function Library if you don't have any experience with functions. The Insert Function command, on the other hand, may be a helpful way for experienced users to quickly locate a function. 
 
    To Use the Insert Function Command 
 
    
    	 Choose the cell where the function will be placed.  
 
    	 Click the Insert Function command from the Formulas tab on the Ribbon.  
 
    	 A dialogue box for inserting a function would appear.  
 
    	 Type a few keywords that describe the computation you want the function to do, then press Go.  
 
    	 Look at the results to locate the function you like, then press OK.  
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    	 The Arguments for Functions dialogue box will appear.  
 
    	 Click OK when you're done.  
 
    	 The function will be analyzed, and the outcome will be shown in the cell.  
 
   
 
   

 

 Formatting Cells 
 
    By default, all cell content has the same formatting, making a workbook with a lot of information difficult to read. Basic formatting will help you design the texture of your workbook, allowing you to highlight particular sections and making your content easier to understand and view. 
 
    To Change the Font Size 
 
    
    	 Choose the cells you need to modify. 
 
   
 
    [image: Selecting a cell] 
 
    
    	 Select the desired font size on the Home tab by clicking the drop-down arrow next to the Font Size command. 
 
   
 
    [image: Selecting a font size in the dropdown menu] 
 
    
    	 The chosen font size will be applied to the text. 
 
   
 
    [image: The selected cell is a larger font size now] 
 
    You can also use your keyboard to enter a customized font size or use the Increase and Decrease Font Size controls. 
 
    [image: The custom font box, increase font size button, and decrease font size button] 
 
    To Change the Font 
 
    Every new workbook's font is set to Calibri by default. However, Excel has a variety of fonts that you can use to modify your cell text.  
 
    
    	 Choose the cells you want to update. 
 
   
 
    [image: Selecting a cell] 
 
    
    	 Select the desired font by clicking the drop-down arrow next to the Font command on the Home tab. 
 
   
 
    [image: Selecting a font in the dropdown menu] 
 
    
    	 The text will change to the font you've chosen. 
 
   
 
    [image: The selected cell is a different font now] 
 
    When composing a workbook at the workplace, choose a font that is easy to read. Standard reading fonts include Times New Roman, Cambria, Calibri, and Arial. 
 
    To Change the Font Color 
 
    
    	 Choose the cells you want to update. 
 
   
 
    [image: Selecting a cell] 
 
    
    	 Select the desired font color by clicking the drop-down arrow next to the Font Color command on the Home tab. 
 
   
 
    [image: Selecting a color in the dropdown menu] 
 
    
    	 The text will change to the font color you've chosen. 
 
   
 
    [image: The selected cell is a different color now] 
 
    To see more color options, go to the bottom of the menu and choose More Colors. 
 
    [image: Selecting more colors.] 
 
    To Use the Italic, Bold, and Underline Commands 
 
    
    	 Choose the cells you decide to modify. 
 
    	 On the Home tab, select the Italic (I), Bold (B), or Underline (U) command. We use the bold command in the example below. 
 
   
 
    [image: Clicking the Bold button] 
 
    
    	 The text will be styled in the chosen format. 
 
   
 
    [image: The selected cell is now bold] 
 
    You can also make selected text italicized by pressing Ctrl +I, bold by pressing Ctrl +B, and underlined by pressing Ctrl +U on your keyboard. 
 
    Fill Colors and Cell Borders 
 
    You can create defined and clear boundaries for different segments of your worksheet using cell borders and fill colors. To further distinguish our header cells from the rest of the worksheet, we'll add cell borders and fill color to them. 
 
    To Add a Fill Color 
 
    
    	 Choose the cells you decide to modify. 
 
   
 
    [image: Selecting cells] 
 
    
    	 On the Home tab, select the fill color you want to use by clicking the drop-down arrow next to the Fill Color command. 
 
   
 
    [image: The Fill Color dropdown menu] 
 
    
    	 The fill color you choose will appear in the cells you select. We also modified the font color to white to make the dark fill color more readable. 
 
   
 
    [image: The fill color has been applied to the selected cells] 
 
    To Add a Border 
 
    
    	 Choose the cells you decide to modify. 
 
   
 
    [image: Selecting cells] 
 
    
    	 On the Home tab, select the border style you want to use by clicking the drop-down arrow next to the Borders command. 
 
   
 
    [image: Borders dropdown menu] 
 
    
    	 The border style you choose will appear. 
 
   
 
    [image: The borders have been applied to the selected cells] 
 
    With the Draw Borders tools at the bottom of the Borders drop-down menu, you can draw borders and adjust their line style and color. 
 
    [image: The Draw Borders submenu] 
 
    Align Text in a Cell 
 
    If you want to improve the visual presentation of your data by realigning text in a cell, follow these steps: 
 
    
    	 Choose the cells in which you want the text to be aligned. 
 
    	 Select one of the following alignment choices from the Home tab: 
 
   
 
    [image: Alignment of text] 
 
    
    	 Select Middle Align [image: Button image], Top Align [image: Button image], or Bottom Align [image: Button image] to align text vertically. 
 
    	 Select Align Text Right [image: Button image], Align Text Left [image: Button image], or Center [image: Button image] to align text horizontally. 
 
   
 
    
    	 If you have a large line of text, a part of the text will be hidden. Wrap Text can be used to correct this without changing the column width. 
 
    	 Click Merge and Center to center text that spans several columns or rows. 
 
   
 
    Format Painter 
 
    You can use the Format Painter command on the Home tab to copy formatting from one cell to another. The Format Painter will copy the formatting from the selected cell when you click it, which can then be pasted to any cells by clicking and dragging it over them. 
 
    [image: Screenshot of Format Painter command] 
 
   

 

 Relative Cell References 
 
    All the cell references are relative references by default. They adjust depending on the relative location of columns and rows when copied through many cells. The formula becomes =A2+B2 when you copy it=A1+B1 from row 1 to row 2. If you need to replicate the same equation through several rows or columns, relative references come in handy. 
 
    Using Relative References to Generate and Copy a Formula 
 
    If you want to make a formula that multiplies each item's price by the quantity, it's illustrated in the following example. You can make only one formula in cell D2 and copy it to the other rows instead of making a different formula for each row. You must use relative references for the formula to calculate the total for each item correctly. 
 
    
    	 Choose the cell where the formula would be inserted. Select cell D2 for this example. 
 
    	 To calculate the total quantity, enter the formula. Type =B2*C2 in the example below. 
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    	 On the keyboard, press Enter. The formula would be applied, and the output will show up in the cell. 
 
    	 Find the fill handle within desired cell's lower-right corner. You must find the fill handle for the D2 cell in this example. 
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    	 Move the fill handle over the cells you want to fill by clicking, holding, and dragging it.  
 
    	 Let go of the mouse. The formula will be copied with relative references to the chosen cells, and the values will be determined in each one.  
 
   
 
    Note: To double-check for the formula’s accuracy in the filled cells, double-click them. Depending on the rows, each cell's relative cell references should be different. 
 
   

 

 Absolute Cell References 
 
    When filling cells, there are times when you don't need a cell reference to change. Absolute references, unlike relative references, do not alter when copied or filled in. To hold a row and column constant, use an absolute reference. The introduction of a dollar sign ($) to a formula designates an absolute reference. It may come before the column or row reference, or both. 
 
    When creating formulas with absolute references, you'll usually use the $A$2 format. The other two formats are much less often used. 
 
    Note: To shift between relative and absolute cell references when writing a formula, click the F4 key on your keyboard. This is a short and simple way to incorporate an absolute reference. 
 
    Using Absolute References to Copy and Generate a Formula 
 
    Using the sales tax rate of 7.5% in cell E1 to determine the sales tax on all goods in column D in the following example. In this case, the $E$1 absolute cell reference will be required in the formula. Since each formula uses the same tax rate, the reference would stay the same when the formula is copied and pasted onto other cells in column D. 
 
    
    	 Choose the cell where the formula would be inserted. In this case, choose cell D3.  
 
    	 To evaluate the desired value, enter the formula. Type =(B3*C3) *$E$1 for this case.  
 
    	 On the keyboard, press Enter. The formula will function, and the product will emerge in the cell.  
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    	 Locate a fill handle within the required cell's lower-right corner.  
 
    	 Release the mouse. The formula would be copied with an absolute reference to the selected cells, and the values will be determined in each cell. 
 
   
 
    

  

 

 Chapter 5. The Topics Most Beginners Struggle With the Most 
 
      
 
    Charts and graphs help you make sense of your data by visualizing numeric values in an easy-to-understand way. Even though these two words are often utilized interchangeably, they have distinct meanings. Graphs are by far the simplest graphical representation of numbers and they usually show data point values over time. Charts are much more complicated since they help you connect parts of any data set to other data in the same software package. Charts are also more appealing than diagrams because they often have a shape that is distinct from the standard x- and y-axis.  
 
    In reports, charts and graphs are often used to provide a brief snapshot of developments or outcomes to management, clients, or team members. You can make a chart and graph to display almost every type of statistical data, saving you the time and effort of sifting through spreadsheets to identify relationships and patterns.  
 
    Excel makes it simple to produce charts and graphs, particularly since you can store data in your Excel Workbook instead of importing it from another application. Excel also comes with several pre-made charts and graph formats from which you can choose one that reflects the data relationship you would like to emphasize.  
 
   

 

 Tired of Those Static Spreadsheets?  
 
    While you might be acquainted with Microsoft Excel, it was never intended to be used for work management. Compare the differences between Excel and Smartsheet in five areas: work management, visibility, accessibility, collaboration, and integration.  
 
   

 

 Types of Charts and Graphs in Excel  
 
    Excel has a huge chart and graph library to allow you to visually display your results. Although several chart styles could “work” for a given data collection, it’s essential to select a chart style that best suits the story you would like your data to tell. You can, of course, apply vector graphics to a chart or graph to enrich and modify it. There are five different types of charts and graphs in Microsoft Excel:  
 
    Column Charts 
 
    Column charts are among the most widely used charts and are generally used to evaluate data or when you have several divisions of one component (for instance, multiple genres or products). Clustered, staggered, 100% stacked, 3D stacked, 3D clustered, 3D 100% stacked, and 3D is the seven-column chart forms available in Excel. Choose the visualization that best tells the story of your results.  
 
    [image: Excel column charts] 
 
    Bar Chart 
 
    The biggest difference between a bar chart and a column chart is that the bar in a bar chart is horizontal rather than vertical. While some use column charts to express negative values since it is simpler to visualize negatives vertically on a y-axis, bar charts and column charts can be used interchangeably.  
 
    [image: Excel bar charts] 
 
    Pie Charts 
 
    Use pie charts for measuring a percentage of the whole (the “whole” means all the values of the data). Each meaning is expressed by a pie slice, allowing you to see the proportions. There are five different types of pie charts: a pie, a pie of a pie (which divides a pie into two to demonstrate the proportions of its subcategories), a bar of a pie, a 3D pie, and a doughnut.  
 
    [image: Excel pie charts] 
 
    Line Charts 
 
    Instead of static data points, a line chart works best for displaying patterns over time. The lines connect every data point, allowing you to see if the value(s) improved or declined over time. The line, 100% stacked line, stacked line, line with markers, stacked line with markers, 100% stacked line with markers, and 3D line are the seven-line chart variants.  
 
    [image: Excel line charts] 
 
    Scatter Charts 
 
    Scatter charts are used to display how one variable affects another. These are identical to line diagrams in that they help display improvements in variables over time. (This is referred to as correlation.) Bubble charts, which are a common chart category, are classified as scatter charts. The scatter with smooth lines and markers, scatter with smooth lines, scatter with straight lines and markers, scatter with straight lines, bubble, and 3D bubble are the seven scatter chart options.  
 
    [image: Excel scatter charts] 
 
    In addition, there are four minor divisions. These graphs are more case-specific:  
 
    Area Charts 
 
    Like line charts, these charts depict shifts in values over time. On the other hand, area charts are useful for highlighting differences in transitions across multiple variables since the area under every line is solid. Area, 100% stacked area, stacked area, 3D area, 3D stacked area, and 3D 100% stacked area are the six types of area charts.  
 
    [image: Excel area charts] 
 
    Stock 
 
    This form of the graphic is utilized in financial reporting and by investors to show the peak, low, and closing price of a stock. However, if you choose to represent a range of the value (or a range of its expected value) and its exact value, you could use a stock chart in this case. Choose from stock chart options such as open-high-low-close, volume-high-low-close, high-low-close, and volume-open-high-low-close.  
 
    [image: Excel stock charts] 
 
    Surface 
 
    To display data on a 3D image, use the surface chart. Wide data sets, data sets of more than two variables, and data sets containing groups inside a single variable can be expressed better with the additional plane. On the other hand, surface charts can be difficult to interpret, so ensure your audience is comfortable with them. 3D surface, wireframe 3D surface, contour, and wireframe contour are the surface chart options.  
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    Radar 
 
    A radar map is useful for displaying data from different variables in comparison to one another. The center point is the starting point for all variables. To use a radar chart effectively, compare all factors to one another; these charts are frequently used to compare the strengths and disadvantages of various goods or employees. Radar, radar with markers, and filled radar are the three kinds of radar charts.  
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    The waterfall chart, which is a set of column graphs that display positive and negative changes over time, is another common chart. A waterfall map is not present in Excel, so you could download a guide to make the task simpler.  
 
    [image: Waterfall chart template for Excel] 
 
   

 

 Top Five Excel Chart and Graph Training Points  
 
    While Excel offers multiple style and styling presets to improve the look and readability of a table, using them does not guarantee that you can get the most out of the chart and graph facility. The top five best practices for making your chart and graph as simple and practical as possible are outlined below:  
 
    Clean It Up 
 
    Cluttered diagrams, such as those with many colors and text, are tough to interpret and don't stand out. Remove all distracting detail so viewers can concentrate on the argument you're attempting to make.  
 
    Select the Most Appropriate Themes 
 
    When choosing a theme, think about the audience, the subject, and the chart's key point. Though it's interesting to try various models, pick the one that best suits your needs.  
 
    Use Text Carefully 
 
    Even though maps and graphs are mostly visual resources, you will almost always show the text (like axis labels or titles). Be concise but precise and deliberate regarding the text direction in every document (it isn't very pleasant to turn your head to read text written horizontally on the x-axis, for instance).  
 
    Place Elements Carefully 
 
    Pay close attention to where names, stories, icons, and different graphical elements are placed. They can complement the graph rather than subtract from it.  
 
    Before Making a Chart, Sort Your Data 
 
    Before making a chart, people sometimes fail to sort their data or delete duplicates, which makes their visual unintuitive and may produce errors.  
 
   

 

 Chart Data in Excel  
 
    To create an Excel chart and graph, you must first supply to Excel some data to work with. You'll learn how to chart data using Excel in this chapter.  
 
    Step 1: Enter Data in a Worksheet  
 
    
    	 Choose New Workbook from the File menu in Excel.  
 
    	 Complete the details with data you intend to use in a graph or map. You're comparing the benefit of five different items from 2013–2017 in this case. Be sure all the columns and rows have numbers. As a result, you'll be able to convert your data into charts and graphs with simple axis marks.  
 
   
 
    [image: How to chart data in Excel] 
 
    Step 2: Select Any Range to Make Chart and Graph From the Workbook Data  
 
    
    	 By moving your cursor over the cells that hold the data you have chosen to include in the graph, you will highlight it.  
 
    	 Now choose a chart form after the cell selection has been outlined in gray.  
 
   
 
    [image: Creating a graph in Excel] 
 
    You'll go into the basics of making a chart (a clustered column) in Excel in the following part of this chapter. 
 
   

 

 Making a Chart in Excel  
 
    Once you've entered your data and selected a cell set, you'll need to select a chart form to represent it. You'll construct a chart (a clustered column) in the following example from the data you used in the previous section.  
 
    Step 1: Select the Chart Type  
 
    Click on the Insert button on the top ribbon until your data has been outlined in the workbook. A segment with many chart choices is located around halfway down the toolbar. Recommended Charts feature most prominently; however, you can choose a different version by clicking either of the drop-down menus.  
 
    [image: How to select chart type in Excel] 
 
    Step 2: Create Your Desired Chart  
 
    Choose Clustered Column from the Column Chart button on the Insert tab. 
 
    [image: How to select Excel chart] 
 
    Excel will generate a cluster chart column based on the data you've chosen. The chart will be displayed in the center of the workbook.  
 
    To give your chart a name, double-click Chart Title and enter a title. This graph is referred to as “Product Profit 2013–2017.”  
 
    [image: How to name a chart in Excel charts] 
 
    The remainder of the walkthrough will be based on this chart. To follow this, you can download the same chart.  
 
    [image: Column chart in Excel] 
 
    Cart Design and Format are the two toolbar sections you can utilize to make changes to the chart. Excel applies to style, layout, and format preset to charts and graphs by default; however, you can customize them by exploring the tabs. Following that, the next section explains the Chart Design options. 
 
    [image: How to make adjustments to your chart in Excel] 
 
    Step 3: Add the Chart Elements  
 
    By adding chart components to a graph or chart, you can improve it by explaining details or adding meaning. Using the Add Chart Feature drop-down menu in the top-left corner, you can choose a chart element (below the Home tab).  
 
    [image: How to add chart elements in Excel] 
 
    To Hide or Display Axes  
 
    
    	 Axes can be chosen. To view both horizontal and vertical axes on your chart, Excel automatically pulls the column and row headers from your chosen cell set (Under Axes, there is a checkmark beside Primary Horizontal and Primary Vertical.)  
 
   
 
    [image: How to display or hide axes in Excel charts] 
 
    
    	 To delete the view axis from the chart, uncheck these choices. In this case, selecting Primary Horizontal deletes the year labels from your chart's horizontal axis.  
 
   
 
    [image: How to remove display axis in Excel charts] 
 
    More Axis Choices... opens a window with extra formatting and text options, such as inserting tick marks, identifiers, or numbers, or the changing text color and height, from the Axes drop-down menu.  
 
    [image: Axis dropdown menu in Excel] 
 
    To Add Axis Titles  
 
    Select Axis Title from the drop-down menu after clicking Add the Chart Element. Since axis names are not immediately added to charts in Excel, either the Primary Horizontal or Primary Vertical will be uncontrolled.  
 
    [image: Add chart elements in Excel] 
 
    A script box will appear here on the chart when you press Primary Horizontal and Primary Vertical to generate axis names. In this case, press both. Fill in the axis titles. Add the titles “Year” and “Profit” to this example.  
 
    [image: Create axis titles in Excel] 
 
    To Move or Remove Chart Title 
 
    Select Chart Title from the Add Chart Elements in the drop-down menu. The four options available are None, Above the Chart, Focused Overlay, and Further Title Choices.  
 
    [image: How to remove or move chart title in Excel] 
 
    To delete the chart title, choose None.  
 
    To put a title above your chart, click Above Chart. Excel will automatically put a chart title above your chart if you make one.  
 
    To put the title inside the chart's gridlines, choose Centered Overlay. This alternative should be used with caution: you wouldn't want your title to obscure any of the data or clutter the graph (like in this example below).  
 
    [image: Chart title in Excel] 
 
    To Add Data Labels 
 
    Select Data Labels from the Add Chart Elements menu. For the data labels titles, there are six options: Middle, Inside End, Outside End, Inside Base, and More.  
 
    [image: How to add data labels in Excel charts] 
 
    Every data point calculated in your map has a unique mark thanks to the four positioning choices. Select the desired option. If you have a limited number of detailed data points or a lot of extra room in the chart, this customization may be useful. Adding data labels to the chart (clustered column), on the other hand, would certainly appear cluttered. This is how choosing the Center data label would appear, for instance.  
 
    [image: Add specific labels in Excel charts] 
 
    To Add a Data Table 
 
    Select Data Table from the Add Chart Elements drop-down menu. By pressing Further Data Table Choices, you can use three pre-formatted options as well as an expanded menu:  
 
    [image: How to add a data table in Excel] 
 
    
    	 The default setting is None, which means that a data table isn't duplicated inside a chart.  
 
    	 Legend Keys shows the data set by displaying a data table under the list. The legend is color-coded as well.  
 
   
 
    [image: Excel chart with legend key ] 
 
    
    	 A data table is often shown underneath the chart with No Legend Keys but without a legend.  
 
   
 
    [image: Excel chart with no legend key] 
 
    Note: If you plan to add a data table, you'll need to expand your chart to make room for it. To scale your chart, click on the corner and move it to the desired height.  
 
    To Add Error Bars 
 
    Select Error Bars from the Add Chart Elements menu. There are four choices on More Error Bar Options: None (default), 5% (Percentage), Standard Error, and Standard Deviation. Using various standard equations to isolate errors, error bars offer a visual image of a possible error in the displayed results.  
 
    [image: How to add error bars in Excel] 
 
    When you choose Standard Error from the choices, you will see a chart like the one shown below.   
 
    [image: Standard error in Excel charts] 
 
    To Add Gridlines 
 
    Gridlines can be added to a chart by clicking Add Chart Elements and then Gridlines. There are four variations: Prime Major Horizontal, Prime Major Vertical, Prime Minor Horizontal, and Prime Minor Vertical, whereas there are many Gridlines Options. Excel automatically adds Prime Major Horizontal gridlines to a column table.  
 
    [image: How to add gridlines in Excel] 
 
    By pressing all the options, you can add as many distinct gridlines as you want. Here's how your chart would appear with all four gridline choices selected:  
 
    [image: Gridline options in Excel charts] 
 
    To Add a Legend  
 
    Select Legend from the Add Chart Elements drop-down menu. There are five legend positioning options in contrast to the many Legend Preferences: None, Correct, Top, Left, and Bottom.  
 
    [image: How to add a legend in Excel] 
 
    The type and format of the chart will determine where the legend is placed. Select the option that appears to be the most appealing on your graph. When you choose the placement of the Right legend, this is what your chart looks like:  
 
    [image: Where to add legend in Excel] 
 
    Adding Lines to a Clustered Column Chart: Lines aren't accessible for column charts (clustered). However, in some chart categories where you are comparing two factors, you can add lines to the chart after making the right choice (e.g., goal, average, comparison, etc.).  
 
    To Add a Trendline 
 
    Select Trendline from the Add Chart Elements drop-down menu. There are five choices: None (default), Linear Forecast, Linear, Exponential, and Moving Average, compared to Further Trendline Options. Be sure you're using the right tool for the data collection. In this case, you'll choose Linear. 
 
    [image: Add a trendline in Excel] 
 
    Excel provides the trendline for every commodity if you're evaluating five different goods over time. Click on Product A and then the blue OK key to building the linear trendlines for the product.  
 
    [image: Add a linear trendline in Excel] 
 
    The dotted trendlines will now appear on your chart to reflect the linear progression of Product A. The words “Linear (Product A)” has now been added to the legend.  
 
    [image: How to display linear progression in Excel chart] 
 
    Double-click on Trendlines to see a trendline equation in your chart. On the right-hand side of the screen, a Format Trendlines window will appear. At the bottom of the window, check the box beside the Display equation in the chart. The equation is now visible on the chart.  
 
    [image: How to format a trendline in Excel chart] 
 
    Note: You can make as many trendlines as you like with each attribute in the chart. Here's an illustration of a chart of trendlines for Products A and C.  
 
    [image: How to make multiple trendlines on Excel chart] 
 
    Up/Down Bars cannot be used in the column chart, yet they can be used in line charts to display rises and declines in data points.  
 
    Step 4: Adjust a Quick Layout  
 
    Quick Layout is the toolbar's second drop-down menu, and it helps you easily adjust the layout of items in the chart (legends, titles, clusters, etc.).   
 
    [image: How to change layout of elements in Excel chart] 
 
    There are eleven quick layout choices. Hover the cursor over these various choices for a description, then choose what you need to use.  
 
    [image: Different layout options for chart in Excel] 
 
    Step 5: Change the Colors  
 
    Change Colors in the next drop-down menu in the toolbar. Choose the color scheme that best suits your needs (these can be aesthetic and complement the colors and theme of your brand).  
 
    [image: Color palette for Excel charts] 
 
    Step 6: Change the Style  
 
    There are fourteen chart forms used for the charts (cluster column). The chart will be shown in Style 1 by default; however, you can adjust it. To see further choices, click the arrow to the right of the picture bar.  
 
    [image: Chart styles in Excel] 
 
    Step 7: Switch Column/Row  
 
    To rotate the axes, click the Switch Row/Column button on your toolbar. Notice that flipping axes for each chart often isn't useful, for instance, if you have more than two variables.  
 
    [image: Flip axis on excel chart] 
 
    Switching the column and row, in this case, flips the product and year (profit remains on the y-axis). The graph is now organized by product (rather than by year), and a color-coded legend corresponds to a year (not a product). To avoid doubt, go to the legend and change the Series to the actual years.  
 
    [image: How to flip axis on Excel chart] 
 
    Step 8: Select the Data  
 
    To adjust the context of your files, click the Select Data button on the toolbar.  
 
    [image: How to change range of data on Excel chart] 
 
    A window opens. Click the Ok button after typing in the cell set you want. This latest data set is reflected in the table automatically.  
 
    [image: Changing data range in Excel chart] 
 
    Step 9: Change the Chart Type  
 
    Change a chart type from the drop-down menu.  
 
    [image: How to change chart type in Excel] 
 
    You can adjust the chart category to each of Excel's nine chart types from here. It is essential to double-check that the data is suitable for the chart format you've chosen.  
 
    [image: Different types of charts in Excel] 
 
    By pressing Save as Template..., you can save the chart as a template.  
 
    You'll be presented with the dialog box in which you can give your design a name. To organize documents efficiently, Excel can automatically generate a folder for the models. To save your work, click the Save icon.  
 
    [image: Create a chart template in Excel] 
 
    Step 10: Move a Chart 
 
    On the far right of your toolbar, click the Move Chart button.  
 
    [image: Moving an Excel chart] 
 
    You'll see a discussion box in which you can select where to put the chart. You can either use this box to make a new layer (New sheet) or use it as an entity in another sheet. To continue, press the blue OK key.  
 
    [image: How to move an Excel chart] 
 
    Step 11: Change the Formatting  
 
    You can adjust the colors, scale, design, fill, and orientation of all components and text in a chart, as well as insert shapes using the Format tab. To have a chart represent your company's brand or style, go to the Format tab and use an available shortcut (images, colors, etc.).  
 
    [image: Change chart format in Excel] 
 
    Select the chart feature you want to update from the drop-down menu on the top-left of your toolbar.  
 
    [image: How to change chart formatting in Excel] 
 
    Step 12: Delete a Chart 
 
    Simply choose a chart and press the Delete button on the keyboard to delete it.  
 
    How You Can Make the Graph Using Excel  
 
    Although graphs and charts are two different features, Excel groups all graphs into the chart categories mentioned in previous sections. Follow the steps below and choose the right graph form to generate a graph or another type of chart.  
 
    
    	 To make a graph with workbook data, select a range  
 
    	 By moving your cursor over cells that hold data you want to include in a graph, you will highlight them.  
 
    	 The grayed-out cell contents will be illuminated. 
 
   
 
    [image: Creating a graph in Excel] 
 
    
    	 After the text has been outlined, you can choose a graph (Excel refers to a chart).   
 
    	 On the toolbar, choose Recommended Charts from your Insert tab. Then choose the graph form you want to use.  
 
   
 
    [image: Types of charts and graphs in Excel ] 
 
    [image: How to choose the type of chart or graph in Excel] 
 
    You now have the graph on your screen. To personalize your graph, repeat the measures outlined in the previous section. When making a graph, all the functions for making a chart remain the same. 
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 Add a Header or Footer  
 
    Microsoft excel is the best application to use to add a header and footer to all the sheets. You can also do this in other word processing programs like google docs. But in Microsoft excel it is done in a very easy manner.  
 
    
    	 Click the File Tab, Click Options.  
 
    	 From the drop-down list click Edit.  
 
    	 Click the tab that says Trust Center.  
 
    	 Click Trust Center Settings  
 
    	 Click the Trust Center Settings button.  
 
    	 Click the Edit Defaults button.  
 
    	 Under the Excel Options heading on the left side, expand the General heading and scroll down to the sheet tab on the right side of the dialog  
 
    	 Click on the View tab  
 
    	 Under the Misc heading, check Show Document Title and Check Show Summary under the General subheading.  
 
    	                      Click OK to close the settings dialog box.  
 
    	                      Restart Excel  
 
   
 
    To add header and footer:  
 
    
    	 Open the file that you wish to add the title or the footer too.  
 
    	 Press F1. It will open the Help window. Click on the “See Other Microsoft Office Help Contents” link. The option will take you to your Excel help page.  
 
    	   Scroll to the “Adding a header or footer to your worksheet” section. You should see the images with your solution. Click on the links and you will see the images in more detail. See the image below.  
 
    	 Click the Apply button and close the window.  
 
    	  Go back to the excel file. Click the File Tab and click on Edit.  
 
    	 In the opened dialog box, click Options.  
 
    	 Click the tabs, and from the General tab, click on the Change button.  
 
    	 Scroll down to the Sheet tab and select Show document name or title. Select the option you want to see in the bottom right corner.  
 
    	 Click OK. Restart Excel  
 
   
 
   

 

 Formatting Excel Table  
 
    How to Extend a Table in Excel?  
 
    When you type something in a cell next to it, the Excel table extends to accommodate the new details. When combined with formal sources, this automatically generates a complex spectrum for the formulas. Click Ctrl + Z if you don’t want the latest data to be used in the chart. This would erase the table expansion while retaining the data you entered. A table may also be manually extended by sliding a small handle in the bottom-right corner.  
 
    [image: Extend a table by dragging the handle.] 
 
    You may also use the Resize Table command to add and delete columns and rows. Here’s how to do it:  
 
    
    	 Choose a location in your table by clicking somewhere on it.  
 
    	 In the Properties group of the Design tab, select Resize Table.  
 
    	 Click the range to be used in the table from the dialog box that emerges.  
 
    	 Choose OK.  
 
   
 
    [image: Resize a table.] 
 
    How to Change Table Style?  
 
    When you insert a table in Excel, it is immediately styled with the default theme. To modify a table’s style, follow these steps:  
 
    
    	 Choose a cell in the table that you want to work with.  
 
    	 In the Table Styles group of the Design tab, choose the theme you choose to use. Click the Further button in the lower-right corner to show all the styles.  
 
   
 
    [image: Changing a table style]  
 
    How to Remove the Table Formatting?  
 
    If you want all the features of the Excel table although none of the formatting, such as banded rows, table borders, and so on, you can do so by following these steps:  
 
    
    	 Click on every cell in your chart.  
 
    	 In the Table Styles group of the Design tab, press the More button in the bottom-right corner, then Clear under the table type models. Alternatively, choose None, the first style under Light.  
 
   
 
   

 

 Inserting Signatures Line and Placing Signatures  
 
    Launch the workbook in which you want to use a digital signature but keep in mind that none of the data will be altered or updated. Place the cursor near the point where you want to introduce the digital signature in the blank cell.  
 
    Select Insert > then Signature Line > and also MS Signature Line Along the ribbon area. Take a look at the image below.  
 
    [image: D:\excel book data\a13.JPG] 
 
    After tapping the Office Signature text in Excel 2k7–2k21, a disturbing background menu would appear. Simply select the option to “Do not display the notification again” and click OK to proceed.  
 
    Thus, some Signature Setup context would seem; follow the steps given from here on out:  
 
    
    	 For signature purposes, type the name in the designated text box.  
 
    	 In the assigned signer's name texting box, type the title;  
 
    	 Fill in the required signer's mailing address texting box with the email address;  
 
    	 If you wish to write a comment to the signature text, hit the Allow icon in the Signed dialogue box;   
 
    	 To exit the Signature Setup context toolbar, tap OK.  
 
   
 
    [image: D:\excel book data\a14.JPG] 
 
    [image: D:\excel book data\a15.JPG] 
 
    The signature text is then added to the proximity of a cell by MS-Excel through a graphic object. At step 2, put the pointer inside a larger X symbol that included your name and text. Take a look at the picture.  
 
    [image: 00096.gif] 
 
    Double-click any graphical object in the signature line, to bring up any “Have the Digital ID” dialogue box where one can choose the sort of ID one may need. We'll look at this and see if we can create the digital ID. Please note the following screenshot:  
 
    [image: 00097.jpeg] 
 
    Please note that Excel 2k13–2k21 will not enable anyone to create the first digital ID. You can only do this by pressing the Yes icon in the Get some other Digital ID button and purchasing or installing the Digital ID. Otherwise, press the No option to exit. Also, take a look at the screengrab below.  
 
    Touch OK, then type the information into some other textbox to develop that Web ID dialogue, then click Create. Take a look at this screenshot:  
 
    [image: 00098.gif] 
 
    From the Signing tab, select and edit the first-ever signature image by pressing Choose Picture. Also, take a look at the screenshots.  
 
    [image: 00099.jpeg] 
 
    Enable the Get the Digital ID toolbar by double-clicking the signature text graphic item, then selecting the kind of ID you want. I'm checking to see if you've created a current digital ID. Please see the image below.  
 
    [image: 00100.jpeg] 
 
   

 

 Inserting Symbols  
 
    Using MS Excel to Add Currency, International and Special Symbols  
 
    Bringing characters and special characters within Office text is maybe among the most popular issues, or should we say eternal problems. Notably, symbols and characters are not found on a keyboard. The most general requests include currency symbols like Pound £ Eurozone, Yen/Renminbi, as well as the @ sign, which may or may not still be present on an old keyboard.  
 
    Insert a Symbol  
 
    Insert | Symbol helps to add characters to Word, which is a great choice for occasional use. On the rather far side of the Title, Excel, plus PowerPoint tabs, it's on the Insert category.  
 
    Recently employed symbols are shown in a gallery, allowing you to quickly choose the Symbol you want to use.  
 
    [image: D:\excel book data\a16.JPG] 
 
    Instead, pick More Symbols to see the entire list of symbols in the Symbol dialogue.  
 
    There are approaches to make your preferred choice even though there seems no sign of it.  
 
    Look for the Symbol that appeals to you. We search for a symbol name “plus” in conjunction with the word “Unicode” (for example, “Signature Unicode”), which identifies places with Unicode sign meaning.  
 
    Unicode is a commonly used IT standard for letters and symbols. Every character is assigned a numerical value that is determined by every computer system. In the existing Unicode list, there are over 143,000 characters, including all modern languages as well as a few historical events. The hex Unicode numerical symbol is what you're looking for. They see from the U+ prefix if they want to. The trademark tag, for example, is “U+2122,” as can be seen within the right-hand column.  
 
    [image: 00102.jpeg] 
 
    In the Unicode Character Code list, type the Unicode hex context (hex).  
 
    [image: 00103.jpeg] 
 
    Special Characters  
 
    A minimal list of symbols with shortcut keys can be found on the Specific Character tab.  
 
    [image: 00104.jpeg] 
 
    Tilde Shortcut  
 
    While we believe that two brackets are just a clumsy sort, you can still try faster alternatives. The tilde character, for instance, is rarely used but can be used as a prefix and otherwise suffix for two Autofill character inputs. As an example,  
 
    
    	 The Euro is represented by the symbols ~e or e~  
 
    	 The approved trademark logo is ~r or r~.  
 
    	 The letter ~t or t~ has been a trademark logo.  
 
    	 The Yen symbol is represented by the characters ~y or y~  
 
    	 ~c or c~ seems to be the copyright mark.  
 
   
 
    Symbols Can Be Inserted Through Keyboard Shortcuts, Asci, and Unicode  
 
    Since Excel 2k13, the UNICODE and UNICHAR functions have been available, and they are similar to the previous CODE and CHAR features.  
 
    Since it yields a mark for a given numerical point, the Munich feature is possibly far more useful (UTF-8 and UTF-16).  
 
    
    	 A currency symbol, “Alt0164,” could be accessed.  
 
   
 
           =UNICHAR (1k4) could result in ✔  
 
           =UNICODE (1k4) could result in ✔.  
 
    
    	 A symbol “Alt156” could be accessed to make ¤ a Currency sign.  
 
    	 A symbol “Alt0164” could be accessed to make a £ Pound sign.  
 
    	 A symbol “Alt 0128” could be accessed to make a € Euro sign.  
 
    	 A symbol “Alt36” could be accessed to make a $ Dollar sign.  
 
    	 A symbol “Alt155” could be accessed to make a ¢ Cent sign.  
 
    	 A symbol “Alt157” could be accessed to make a ¥Yen sign.  
 
    	 A symbol “Alt158” could be accessed to make a ₧ Peseta sign.  
 
    	 A symbol “Alt159” could be accessed to make the ƒ Frank / Gulder sign.  
 
   
 
    When we navigate the character code, press and hold ALT to enable the ASCII character while typing 0176 over a numeric keypad, e.g., attach the degree (o) button and press and hold ALT.  
 
    It would be easier if one entered the digits using just the numeric keypad rather than the keyboard also at the top of its alphabetic figures. If the keyboard needs to enter numbers from the numeric keypad, make sure the NUM LOCK controls are turned.  
 
    You should change the currency for just about any cells that require it. Try to ensure cell numbers are set up as currencies when you're seeking something more. To do so, pick the cells you wish to format.  
 
    The numbers in selected cells are configured as Windows standard currency icons using the “Number Layout” dropping list, pick “currency” therein the “Number” segment of the “Home” page.  
 
    To change some currency numbers to a different currency type, including Euros, pick the cells one wishes to change.  
 
    In the “Home” page's “Number” section, hit the “Number Format” icon therein the section's bottom portion.  
 
    “Currencies” should just be picked in the “Category” section on the “Number” tab. Select one of the “Euro” options from the “Symbol” drop-down section, depending on whether you wish the Euro mark before or maybe after the number. Click the “OK” button from the drop-down menu.  
 
    The selected numbers are now associated with a specific currency symbol.  
 
    You may have found a drop-down menu with a currencies mark in the “Number” section of its “Home” tab. This could seem to be a more straightforward method of changing the currency mark for the selected cells.  
 
    If the drop-down “Account Number Format” column is set to “Euro.” Figures would have Euro signs, but those might be displayed in an accounting format that lines up decimal points there in the column.  
 
   

 

 VLOOKUP Function 
 
    The VLOOKUP feature in Excel allows you to look up a specific piece of data in a table or data collection and retrieve the associated data/information. In plain English, the VLOOKUP feature tells Excel to “look for this piece of information (e.g., bananas) in this data collection (a table) and tell me any corresponding information about it (e.g., banana price).”  
 
    The formula is:   
 
    =VLOOKUP (lookup value, table array, col index num, [range lookup])   
 
    To put it another way, the formula says, “Find this piece of information in the following field and send me some matching details from another column.” The following arguments are passed to the VLOOKUP function:  
 
    
    	 Lookup value (necessary argument)—Lookup value defines the value in the first column of a table that we want to look up.  
 
    	 Table array (necessary argument)—The table array represents the data array to be scanned. The VLOOKUP feature looks in the array’s left-most column.  
 
    	 Col index num (necessary argument)—This is an integer that specifies the column number of the supplied table array from which a value should be returned.  
 
    	 Range lookup (selectable argument)—This specifies what this feature can return if it cannot locate an exact match for the lookup value. The value of the statement may be TRUE or FALSE, which means:  
 
   
 
    
    	 TRUE—Estimated match, which means that the nearest match below the lookup value is used if an exact match cannot be sought.  
 
    	 FALSE—Exact match; if an exact match is not detected, an error would be returned.  
 
   
 
    Sort the Information  
 
    The first step in utilizing the VLOOKUP feature is to ensure your data is well-organized and appropriate for it. Since VLOOKUP operates from left to right, you must ensure that the data you wish to look up is to the left of the data you want to extract. e.g.  
 
    [image: vlookup step 1] 
 
    Since bananas are in the leftmost column in the above VLOOKUP illustration, the “healthy table” will quickly run the function to look up “Bananas” and return their price. There is an error message in the “bad table” case because the columns are not in the correct sequence. This is one of VLOOKUP’s most significant flaws, and It’s for this purpose, INDEX MATCH can be used instead of VLOOKUP.  
 
    What to Lookup, Tell the Function  
 
    We say Excel what to see for in this process. First, type the formula =VLOOKUP (and select a cell comprising the data we want to look up. It’s the cell that says “Bananas” in this situation.  
 
    [image: vlookup step 2] 
 
    The Function Where to Look  
 
    In this stage, we select the table containing the data and instruct Excel to look for the details we choose in the previous phase in the leftmost column. In this example, we’ve highlighted the entire table from column A to column C. Excel would search in column A for the details we told it to look up.   
 
    [image: 00137.gif] 
 
    Tell Excel What Column to Output the Data From  
 
    We must say Excel, which column contains the data we want to provide as an output from the VLOOKUP. Excel would require a number that correlates to the table’s column number. Since the output data is in the third column of the table in our case, we use the number “3” in the formula.  
 
    [image: vlookup step 4] 
 
    Approximate or Same Exact Match  
 
    By entering “False” or “True” in the formula, you can say Excel if you’re searching for an exact or estimated match. We want the same or exact match (“Bananas”) in our VLOOKUP function formula example, so we typeface “False” in the formula. We might get a close match if we used “True” as a factor instead.   
 
    When looking up an actual statistic that isn’t in the table, for example, the number 2.9585, an estimated match will be helpful. Excel can search for the nearest to 2.9585 in this situation, even though that number isn’t in the dataset. This would help avoid VLOOKUP formula errors.  
 
   

 

 Make Changes to the Page’s Layout  
 
    We sometimes encounter a problem in which the columns occupy the whole page, but one column does not fit into one page, causing the paper to shift to another page. The Ruler/margins/choices within the Excel Page Layout feature can be used to solve this issue.  
 
    Choose the Excel Page Layout icon from the Ribbon. Then you'll see that there are several operations available, each of which has many options.  
 
    [image: 00161.jpeg] 
 
    Pick the “Margins” button under “Page Layout” to see a list of margin choices. Final Customized Configurations, Standard, Wide, as well as Small margins seem to be the four ideal options. You should pick one who meets your requirements.  
 
    [image: 00162.jpeg] 
 
    Pick “Narrow” margins from the drop-down menu. They reduce margins while also increasing the capacity to receive columns.  
 
    Go over to the “Page Layout” configurations and press that Orientation icon next to the Margins symbol to change the theme.  
 
    [image: 00163.jpeg] 
 
    To have a reasonable printing page, you can, however, change the height of that paper. Then tap the “Size” icon below that “Page Layout” configuration. This choice enables you to change the paper size of the document before printing it.  
 
    Unless the data is large and contains a significant number of rows (let's say 10,000), it will not work on a single page. It will take up several pages. The most serious flaw is that column names become only visible on the first page. So, what about all the other pages that will be filled with data? It'll be difficult to figure out which column refers to which. As a result, knowing the column names of an individual page is required when creating the page.  
 
    To print titles, go over towards the “Page Layout” button and then to the “Print Titles” icon. Choose the symbol.  
 
    When you hit the “Print Titles” button, a current “Page Setup” screen appears with the “Sheet” choice available. 
 
   

 

 How to Switch the Components Forward and Backward?  
 
    Whenever you choose the Shapes tool upon its Insert via ribbon page to generate some Excel artifacts, each type is drawn on its own sheet. This means that all things are self-contained and can be moved to the top of a large number of other pieces. However, there can be times when you desire an object to be placed underneath another item. You'll accomplish this by following the steps below.  
 
    
    	 To change the layout, press on the shape you'd like to change. Around the circumference of an item are small square boxes regarded as handles.  
 
    	 Select a ribbon format tab from the drop-down menu.  
 
    	 In Organize group, touch Send Backward and then use MS-Excel 2k7 and newer versions, press Send Back.  
 
    	 One could make arrangements through picking Carry Forward than Send Backward and otherwise Carry to Front instead Send to Back. MS-Excel moves that object that may have been hidden behind others so that it is visible.  
 
    	 In a stack, shift text boxes and word art and also shapes forward/backward  
 
   
 
    When you introduce photographs, shapes, or other objects to Office papers, they layer up into separate layers right away. Individual pictures, other things, or sets of objects may be added to a stack. For example, you could even shift components forwards or backward inside these stacks, each layer at just one time, or maybe you could consider moving them to the bottom or top of the stack with one move. You would also combine items to generate various results whereas users draw. You should pursue these steps to shift shapes, images, texts, and word art within a stack.  
 
    Drag and drop the WordArt, type, or text boxes one would like to move up or down your stack. Upon this Drawing Resources Layout button, choose either Carry Forward or then Submit Backwards.  
 
    [image: D:\excel book data\a17.JPG] 
 
    You can choose to move the object to a higher layer or towards the top of that stack. Send Backward offers the same choices as Send Forward: below one layer (Send Backward) or down a stack's bottom (Send Backward).  
 
    If you have a range of WordArt, shapes, text boxes, and perhaps other items in MS-Office 2k13 as well as newer launches, it may be easier to have an upwards arrow there in Selection Panel to pass them. The Selection Panel isn't really qualified in Project and also MS 2k10.  
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 Password-Protecting a Workbook 
 
    In certain instances, you may like to have your workbook password specified. If the file is needed to be open, then the user must 1st verify the password, and then it can be opened.   
 
    Follow these steps to set a Workbook password:  
 
    
    	 Use File ➪ Info and press the button Protect Workbook. This button shows a few more choices in a dropdown column.   
 
    	 From the list, pick Encrypt with Password. The MS Excel shows the option for Encrypt File, which is given as under.   
 
    	 Type the name, press OK, and then re-enter.   
 
    	 Select OK and then close your workbook after saving.   
 
   
 
    When the workbook is reopened, you will be asked for a password.   
 
    [image: 00011.jpeg] 
 
    This option is available where a user creates a password for the file. 
 
    

  

 
 
    Freezing Panes and View Options 
 
    Excel includes several tools, such as the option to freeze panes and split the worksheet, making it easier to display content from different sections of the workbook at the same time. 
 
    To Freeze Rows 
 
    You will want to keep some rows or columns in your worksheet visible all of the time, especially header cells. You can scroll through the content while only seeing the frozen cells by freezing rows or columns in place. 
 
    Select the row under the row(s) you want to freeze. 
 
    
    	 On the Ribbon, select the View tab.  
 
    	 Select Freeze Panes from the dropdown menu after selecting the Freeze Panes command.  
 
   
 
    [image: 00056.jpg] 
 
    As shown by the grey line, the rows would be frozen in place. You will continue to see the frozen rows at the top while scrolling down the worksheet. 
 
    To Freeze Columns 
 
    
    	 Click on the column to the right of the one or more columns you choose to freeze.  
 
    	 On the Ribbon, choose the View button.  
 
    	 Select Freeze Panes from the dropdown menu after selecting the Freeze Panes command.  
 
    	 As shown by the grey line, the column would be fixed in place. You will continue to view the frozen column on the left while scrolling through the worksheet.  
 
   
 
    Click on the Freeze Panes command, then choose Unfreeze Panes from the dropdown menu to unfreeze rows or columns. 
 
    To Split a Worksheet 
 
    You may want to compare various parts of the same workbook without having to create a new window. The Split command divides the worksheet into several panes that each scroll independently. 
 
    
    	 Choose the cell where you want the worksheet to be split.  
 
    	 Select the Split command from the View tab on the Ribbon.  
 
   
 
    [image: 00057.jpg] 
 
    
    	 The workbook would be divided into several panes. The scroll bars enable you to compare various parts of the workbook by scrolling across each pane separately.  
 
   
 
    To undo the split, tap the Split command once again. 
 
   

 

 Move or Copy a Worksheet  
 
    To move or copy a worksheet;  
 
    
    	 Go to the Home tab in excel.  
 
    	 Go to the Ribbon and find the “Move” icon.  
 
    	 Then click on the icon and a window appears.  
 
    	 Here, select the source location and then drag the sheet you want to move.  
 
    	 If you are moving from a different location, you will see a blue arrow. There you can see an option to select the location where you want to move the sheet.  
 
    	 If the worksheet is large, you can drag it so that the sheet is in a view you are comfortable with.  
 
    	 Once the sheet is in the desired location, you can double-click on the sheet.  
 
    	 When the sheet is opened in the desired location, it shows the blue arrow symbol. This is to indicate that you have moved it from the source location to the destination location.  
 
    	 If you have moved the sheet from one location to another you can click on the arrow and if you want to move it to another location in that same excel sheet. Or, you can click on the “Paste” icon on the home tab in excel.  
 
    	 This shows you a pop-up window where you can select the location. 
 
   
 
   

 

 Database in Excel 
 
    Excel is made up of rows and columns, and these rows and columns store our data, which is known as records. When we place data in Excel in the form of tables with rows and columns and give the table a name, we are creating a database. 
 
    [image: create excel database] 
 
    How to Create a Database in Excel? 
 
    Since Excel is such a powerful tool that can deal with data all the time, having the data in Excel can make your life easier. If you're working with data from other sources, you might not be able to accurately retain all the formulas, times, formats, and dates. It's important to store data in the appropriate database platform. 
 
    To have proper data in the database format, we must carefully design the Excel worksheet. To make an Excel database, follow the steps below. 
 
    
    	 Step 1: Check that you have all of the required columns and every heading is appropriately named. 
 
   
 
    [image: create excel database 1.1] 
 
    
    	 Step 2: After ensuring the data table’s headers are clear, we can simply start entering data just below the corresponding column headings. 
 
   
 
    [image: create excel database 1.2] 
 
    Columns are referred to as Fields, and Rows are referred to as Records in database terminology. 
 
    You can't leave a single row blank when entering the data. Let's say you've entered the headings in the first row, and now you start entering data from the third row while leaving the second row empty. This is not how things work in the database. 
 
    [image: create excel database 1.3] 
 
    You can’t leave any row empty after entering specific data into the database field; this is not just for the first or second row. 
 
    
    	 Step 3: Each column in the database is referred to as Fields, as previously mentioned. You can't leave a blank field between the data. You must fill out the fields one by one.  
 
   
 
    [image: create excel database 1.4] 
 
    The reason for the emphasis on not having an empty record or field is that when the data has to be exported to other software or the internet, the software assumes that the blank record or field is the end of the data and does not consider the entire data set. 
 
    
    	 Step 4: Enter the data carefully. 
 
   
 
    [image: create excel database 1.2] 
 
    We have data from row 1 to row 5001 in the picture above. 
 
    
    	 Step 5: The last thing is to convert this data into an Excel table. Once you select the data, type Ctrl + T on your keyboard. Check that the “My data has a header’’ checkbox is checked, and the range is properly selected. 
 
   
 
    [image: create table] 
 
    
    	 Step 6: Click on the “Ok” button to finalize the table creation. We now have a table similar to the picture below. 
 
   
 
    [image: Image] 
 
    
    	 Step 7: Give the table an appropriate name under the table design tab. 
 
   
 
    [image: design tab] 
 
    
    	 Step 8: Since we've built a table, any data entered after the last column will automatically expand. 
 
   
 
    The database is now ready. 
 
    

  

 

 Chapter 7. Excel Tips And Tricks 
 
    A spreadsheet is more than just a set of numbers on a tab. To make your spreadsheets look professional, easy to understand, and visually pleasing to your audience is important.  
 
    Your Excel presentation will not impress your audience if it appears clumsy and boring, no matter how many hours of analysis went into it or how relevant the knowledge stored inside is.  
 
    The secrets hidden in this chapter can come in handy whether you are making a report for personal use, passing details to your team, or sharing with your project manager. Let us glance at some of the latest Excel presentation tips to help you make eye-catching spreadsheets.  
 
   

 

 1. Search For Templates Online  
 
    If you are a busy person and you would like to make the most out of your spreadsheet without losing time, you can choose from a variety of purpose-specific templates that include attractive styles, fonts, and colors. To work on a template, simply insert your values, and you are ready to go.  
 
   

 

 2.Name Your Worksheets Correctly  
 
    When it comes to Excel presentations it is mostly about clarity. The significance of a right and accurate project or worksheet name cannot be overstated for this single purpose. It may be an expression, a sentence, or just a single letter. Only make sure it is easy to grasp for you and everyone else with whom you will be sharing the file.  
 
    You must also be sure that the name of your file is different from the titles of other worksheets on your device. After all, what good will all the lessons you are going to practice today do, if you cannot locate the worksheet you used them on?  
 
   

 

 3.Define Your Header/Title  
 
    Anything can work with your header and title, but it must stand out. Your header should clearly communicate the viewer what the file is about at first glance.  
 
    To do this, use a bigger font, underline, and embolden your header. You can also use different colors. Make sure your title stands out while still matching with the template's color scheme and overall aesthetic appearance. For your header, you may also use a different readable.  
 
      
 
    [image: Excel-presentation-tips]  
 
   

 

 4. Dos And Don'ts Of Fonts  
 
    Full transparency: Use a consistent font for your data; you may either use the same font for your header or modify it. To make your worksheet look professional, you should not use more than three fonts in a single presentation.  
 
      
 
    Font type  
 
    Readability should always be a priority. Sans-serif fonts are the right option for your Excel spreadsheet. Calibri, Arial, Helvetica, and Playfair are just a few of the many available fonts you can use. They will bring out the best of your Excel presentation, especially when used with the right spacing, alignment, and color.  
 
      
 
    [image: Excel-presentation-tips]  
 
    Font size  
 
    Even though it usually depends on the presentation, font 12 with double spacing is often recommended to increase readability. As previously mentioned, the header font should be made larger. The headers should be bigger than the subleaders, which should be bigger than the data fonts.  
 
    [image: Excel-presentation-tips]  
 
      
 
    Alignment  
 
    Excel's alignment feature is not used too much. If you want the presentation to appear professional, you will want to use the alignment feature to its full potential.  
 
    If the Alignment is easier at the side, headers should be aligned in the center. Numbers and numerical data should be aligned at the right, while texts must be aligned at the left. In the data input, center alignment is not recommended. To wrap your data or title around a cell, click it, then go to the Home toolbar, select Alignment, and then wrap your text.  
 
    [image: Excel-presentation-tips]  
 
   

 

 5.Create Space For Breathing Room  
 
    When you see a densely packed, clumsy and wordy text or spreadsheet, your brain gets bored reading it even before you begin. However, if the spreadsheet is separated into categories, it becomes more appealing to the eyes and easier for the brain to interpret.  
 
    The B2 rule is the solution: always begin your presentation on row 2 of column B, leaving the A column and the first row blank.  
 
    Also, do not let the document's height and width autofit. Your workspace must enable you to be flexible and creative. Instead, manually change the height and width of the presentation so that it has only enough white space to readability.  
 
    [image: Excel-presentation-tips]  
 
   

 

 6. Add An Image  
 
    Whether it’s a picture, an abstract drawing, or a logo, images go a fair way toward improving your spreadsheet. Some of the stunning presentations you have seen, use images that make their presentations appear official and professional. A thousand words are expressed in pictures. Although Excel is not intended to provide the same presentation as PowerPoint, using an image can help you make the presentation more memorable.  
 
    [image: Excel-presentation-tips]  
 
   

 

 7.Go Off The Grid  
 
    Do you acknowledge that erasing grid lines except those associated with your results would elicit questions about how you managed to do it and whether you use the same Excel program they do? Try it out today.    
 
    Go to the View tab on the ribbon of your spreadsheet.  
 
    Uncheck the box in the Show section, next to gridlines.  
 
    [image: Excel-presentation-tips]  
 
   

 

 8.Zebra Striped  
 
    Rows are stacked on top of each other, zebra stripes are the alternating light and dark shades. This is beneficial in a variety of respects. For starters, it has a pleasing aesthetic that renders your work seem more organized, particularly if you are showing hundreds of rows of details. Second, it aids readability and correlation. A reader will follow a row from the far right to the far left without losing sight of which row he or she is looking at.  
 
    [image: Excel-presentation-tips] 
 
      
 
    When you make a table in Excel, it will result zebra-striped by default (Tip: To create a table easily, pick the data and use shortcut ^ + T on a Mac or Ctrl + T on Windows). You can adjust the color and pattern of your zebra stripes on the Design page, under Table Styles.  
 
    If required, it can also be achieved with a formula in conditional formatting. Conditional formatting is achieved by emphasizing principles that meet those criteria (e.g., all odd-numbered rows). The painter method in the Home toolbar could be used to copy it from one cell to another.  
 
   

 

 9.Use Tables, Graphs, And Charts  
 
    Without any kind of visual representation, presentations are incomplete. You should visually reflect the raw data in the mediums that can be interpreted in a quick look, whether it is a graph, chart, or table. Graphs, charts, and tables are important tools to have, particularly if you have a lot of data that spans several columns and rows.  
 
    The graph, table, and chart features are just like symbiotic siblings in the Excel ecosystem. 
 
      
 
    [image: Excel-presentation-tips]  
 
   

 

 10.Create Cell Styles  
 
    Excel has a number of pre-defined cell styles. However, you may make your favorite custom styles. If you want to keep the visuals consistent, this option might be better than using a template. After you have created a stunning spreadsheet with the your data, save the style and use it in your future presentations too. 
 
    Simply pick the cells you want to save, then go to the Home toolbar, press "more" at the top of the style gallery, and then "new cell style." A style dialog box will appear, allowing you to name the style, change its properties, and save it.  
 
    Why alter something that is not broken and fits well? You can, though, introduce a little variety by switching up the color palette now and then.  
 
   

 

 11.Show Restraint  
 
    You have learned all of these pointers and are ready to begin your presentation; however, avoid overdoing it. To reach the "just enough" middle ground, you must navigate a delicate line between underwhelming and excessive. As in all, make sure the presentation is well balanced.  
 
    

  

 

 Chapter 8. Functions And Formulas 
 
    Any financial analyst invests much more time in Excel than he or she would like to say. We’ve gathered the most relevant and sophisticated Excel formulas that any world-class financial analyst should.  
 
   

 

 Advanced Formulas  
 
    Index Match   
 
    Formula is given as: =INDEX (C3 ratio E9, MATCH (B13, C3 ratio C9,0), MATCH (B14, C3 ratio E3,0))   
 
    INDEX MATCH is a versatile Excel formula mix that can help you improve your financial research and modeling. INDEX is a table function that returns the value of a cell depending on the column and row number.  
 
    MATCH returns the row or column direction of a cell.  
 
    Here’s an example of combining the INDEX and MATCH formulas. We look up and return a person’s height based on their name in this case. We should adjust both the name and the height in the calculation since they are both factors.  
 
    [image: Advanced Excel Formulas - Index Match]  
 
    IF in Combination With AND/OR  
 
    The formula is given as:  
 
    =IF (AND (C2 is greater or equal to C4, C2 is less or equal to C5), C6, C7)  
 
    Anyone who has disbursed a significant amount of time working with different financial models understands how difficult nested IF formulas can be. Combining the IF feature with the AND / OR function will make formulas simpler to audit and appreciated by other users. You will see how we combined the individual functions to construct a more advanced formula in the illustration below.   
 
    [image: Advanced Excel Formulas - IF AND]  
 
    OFFSET in Combination With SUM or AVERAGE  
 
    The formula is given as:  
 
    =SUM (B4 ratio OFFSET (B4,0, E2 minus 1))  
 
    The OFFSET function isn’t very complex on its own, but when combined with other functions like SUM or AVERAGE, we can construct a complicated formula. Consider the following scenario: you want to build a complex feature that can sum a variable number of cells. You can only do a static calculation using the average SUM formula, but you can shift the cell relation around by adding OFFSET.  
 
    To make this formula work, we use the OFFSET function instead of the SUM function’s ending comparison cell. This makes the formula complex, and you can tell Excel how many sequential cells you want to sum up in the cell referenced as E2.  
 
    This much more complex formula is shown in the screenshot below.   
 
    [image: sum offset formula]  
 
      
 
    XNPV and XIRR  
 
    Formula: = XNPV (discount rate, cash flows, dates)  
 
    These calculations can prove useful if you work in investment management, market research, financial planning & analysis (FP&A), or some other field of corporate finance that includes discounting cash flows.   
 
    Simply placed, XNPV and XIRR enable you to assign separate dates to each discounted cash flow. The simple NPV and IRR formulas in Excel have the flaw in assuming that the time intervals between cash flows are equivalent. As an economist, you’ll see conditions where cash balances aren’t equally spaced regularly, and this is the formula you need to you solve it.  
 
    [image: XNPV advanced finance formula in Excel]  
 
    SUMIF and COUNTIF  
 
    Formula: = COUNTIF (D5 ratio D12,” is greater or equal than 21″)  
 
    Conditional functions are used effectively in these two developed formulas. All cells that need specific criteria are included in SUMIF, and all cells that need measures are counted in COUNTIF. For example, suppose you may want to figure out how many containers of champagne you need for a client event by counting all cells that are larger than or equivalent to 21 (the minimum consumption age in the United States). As seen in the screenshot given below, COUNTIF may be used as an advanced approach.  
 
    [image: COUNTIF formula]  
 
    PMT and IPMT  
 
    Formula: =PMT (# of periods, interest rate, present value)  
 
    You’ll need to know these two formulas if you operate in real estate, commercial banking, FP&A, or other financial analyst jobs that deal with debt schedules.  
 
    The PMT theorem calculates the worth of making equivalent payments throughout a loan’s existence. You should do that in combination with IPMT (which shows you how much interest you’ll pay for the same kind of loan), then different principal and interest payments. Here’s how to use the PMT feature to calculate the annual mortgage payment on a $1 million loan with a 5% interest rate over 30 years.  
 
    [image: 00039.jpeg]  
 
    LEN and TRIM  
 
    Formulas are given below:  
 
    =TRIM (text) &  
 
    =LEN (text)   
 
    The formulas mentioned above are a little less general, but they are complex. Financial experts who need to manage and manipulate vast volumes of data may benefit from them. Unfortunately, the data we receive is not necessarily well-organized, and problems such as extra spaces at the beginning or end of cells will arise.  
 
    The LEN formula returns the number of characters in a specified text string, which is helpful when you need to count how many characters are in a text. You will see how the TRIM algorithm cleans up the Excel data in the illustration below.  
 
    [image: Advanced Excel - TRIM]  
 
    CONCATENATE  
 
    The formula is given as:  
 
    =CONCATENATE(A1;”more text.”)   
 
    Concatenate isn’t even a function in and of itself; It’s just a creative way of bringing data from multiple cells together and making worksheets more complex. For financial analysts doing financial simulation, this is a valuable instrument.   
 
    In the illustration below, the text “New York” plus “,” is combined with “NY” to form “New York, NY.” This enables you to make dynamic worksheet headers and labels. Instead of upgrading cell B8, you will also upgrade cells B2 and D2 independently. This is a great attribute to have while dealing with vast data collection.  
 
    [image: Concatenate formula Excel Example]  
 
    CELL, MID, LEFT, and RIGHT Functions  
 
    These complex Excel features may be merged to produce specific, very complicated, and advanced formulas. The CELL feature may return a range of data about a cell’s contents (such as its name, location, row, column, and more). The LEFT function returns the text from the cell’s beginning (left to right), the MID function returns the text from any cell’s start point (left to right), and the RIGHT function returns the text from the cell’s end (right to the left).  
 
    The three formulations are shown in the diagram below.  
 
      
 
   



 

 Chapter 9. Exercises 
 
    Using Excel To Record Income And Expenses And Set Personal Budgets.  
 
    Now it’s time to put everything you have learned so far into practice. 
In this excercise, you will make two workbooks: one for incomes and one for budgets.  
 
    When your tasks will be complete, your workbooks should look like this:  
 
      
 
    [image: Case Study: Managing personal finance using Microsoft Excel]  
 
    [image: Case Study: Managing personal finance using Microsoft Excel]  
 
    Let’s start: 
 
    
    	 Open Excel.  
 
    	 Create a new workbook.  
 
   
 
    Income sheet  
 
    
    	 Rename your Sheet1 to "Income"  
 
    	 Enter the following data:   
 
   
 
    Projected Monthly Income  
 
    
     
      
      	  S/N  
  
      	  Description  
  
      	  Amount ($)  
  
     
 
      
      	  1  
  
      	  Freelance works  
  
      	  2000.00  
  
     
 
      
      	  2  
  
      	  Salary   
  
      	  7850.00  
  
     
 
      
      	  3  
  
      	  Others  
  
      	  1180.00  
  
     
 
      
      	  Grand Total  
  
      	     
  
      	     
  
     
 
     
   
 
       
 
      
 
   



 

 Actual Income  
 
    
     
      
      	  S/N  
  
      	  Description  
  
      	  Amount ($)  
  
     
 
      
      	  1  
  
      	  Freelance works   
  
      	  3400.00  
  
     
 
      
      	  2  
  
      	  Salary  
  
      	  9900.00  
  
     
 
      
      	  3  
  
      	  Others  
  
      	  1250.00  
  
     
 
      
      	  Grand Total  
  
      	     
  
      	     
  
     
 
     
   
 
       
 
   

 

 Formulas for Income sheet  
 
    N:  
 
    
    	 Determine your monthly income, both actual and projected.  
 
    	 Based on the monthly sum, calculate the estimated annual income and actual annual income.  
 
    	 Determine the variance in actual and projected annual income.  
 
    	 Clarify how you are doing by using logical functions.  
 
    	 Use conditional formatting to emphasize your financial management skills.  
 
   
 
   

 

 Tutorial Exercise 1  
 
    
    	 Add up all of the monthly income sources. Make use of the SUM command. This can be done with both predicted and actual monthly earnings.  
 
    	 Multiply the answer to question 1 by 12 to get the annual estimated and actual revenue.  
 
    	 Deduct the estimated annual income from the actual annual income to find the income variance.  
 
    	 Just below the tables, add a comments row. If the difference is less than zero (0), use the IF functions to display "You need to strive extra hard to reach your income goals," else display "Wonderful job working harder and smarter."  
 
    	 If the difference is less than 0, use conditional formatting to convert the text color to red; else, modify the text color to green.  
 
   
 
       
 
       
 
   

 

 Expenditure Sheet  
 
    Add one new sheet and then rename it to Expenditure. Enter the data in the sheet as shown below.  
 
    Budget  
 
    
     
      
      	  S/N  
  
      	  Item  
  
      	  Quantity  
  
      	  Cost  
  
      	  Subtotal  
  
     
 
      
      	  1  
  
      	  Rents  
  
      	  14  
  
      	  540.00  
  
      	     
  
     
 
      
      	  2  
  
      	  Bills  
  
      	  11  
  
      	  550.00  
  
      	     
  
     
 
      
      	  3  
  
      	  School  
  
      	  3  
  
      	  1000.00  
  
      	     
  
     
 
      
      	  4  
  
      	  Groceries   
  
      	  11  
  
      	  700.00  
  
      	     
  
     
 
      
      	  5  
  
      	  Miscellaneous  
  
      	  4  
  
      	  200.00  
  
      	     
  
     
 
      
      	  Grand Total:  
  
      	     
  
      	     
  
      	     
  
      	     
  
     
 
     
   
 
       
 
    Actual income  
 
    
     
      
      	  S/N  
  
      	  Description  
  
      	  Quantity  
  
      	  Cost  
  
      	  Subtotal  
  
     
 
      
      	  1  
  
      	  Rents  
  
      	  14  
  
      	  550.00  
  
      	     
  
     
 
      
      	  2  
  
      	  Bills  
  
      	  11  
  
      	  590.00  
  
      	     
  
     
 
      
      	  3  
  
      	  School  
  
      	  3  
  
      	  1000.00  
  
      	     
  
     
 
      
      	  4  
  
      	  Groceries   
  
      	  11  
  
      	  650.00  
  
      	     
  
     
 
      
      	  5  
  
      	  Miscellaneous  
  
      	  4  
  
      	  300.00  
  
      	     
  
     
 
      
      	     
  
      	  Grand Total:  
  
      	     
  
      	     
  
      	     
  
     
 
     
   
 
       
 
   

 

 Formulas for Expenditure sheet  
 
    You have to:  
 
    
    	 Determine the subtotal.  
 
    	 Compute the grand total using the subtotals.  
 
    	 Calculate the expected annual savings. The difference between the estimated annual income and the actual budget amount is the expected annual savings. This should also be done with actual income and expenditure.  
 
    	 Calculate the variance of the monthly saving.  
 
    	 Just below the tables, add a comments row. If the difference is less than zero (0), display "You have to minimize your expenses." Else, display "Pretty good job of sticking to the budget."  
 
    	 If the difference is less than 0, use conditional formatting to modify the text color to red; else, modify the text color to green.  
 
   
 
   

 

 Tutorial Exercise 2  
 
    Write the formulas that apply to the above settings.  
 
   

 

 Visualizing The Data Using Charts 
 
    Charts are an excellent way to visualize results. For the estimated monthly income, now practice adding a pie chart to your income sheet.  
 
    Your chart can only display data for   
 
    
    	 Column for the subtotal  
 
    	 Column for the subtotal 2. Item column  
 
   
 
    In the Item section, highlight objects 1 to 5.  
 
    Press and hold the Ctrl key and select the subtotals from 1 to 5 in the subtotal’s column.  
 
    From the main menu, select the INSERT tab.  
 
    [image: Case Study: Managing personal finance using Microsoft Excel]  
 
    • Pick a pie chart from the charts ribbon bar by clicking on the pie chart drop-down menu.  
 
    • The pie chart can now resemble the image below.  
 
    [image: Case Study: Managing personal finance using Microsoft Excel]  
 
   

 

 Tutorial Exercise 3  
 
    Create charts for projected income, actual expenditure, and actual income.  
 
      
 
    

  

 
   
   
 Conclusion 
 
      
 
    Microsoft Excel is one of the most popular computer programs because of the significant role it plays in many fields. It is the most frequently used spreadsheet software in many business and educational institutions, and personal data management. The first version of Excel was introduced in 1985. Since then, it has been used to perform formula-based arithmetic and analyses, and other tasks that may involve mathematical calculations. Excel has become popular among companies, individuals, and institutions due to its versatility and capability to serve as a visual basic for a variety of applications. 
 
    Employers value Excel expertise, it will help you get hired by demonstrating that you have strong analytical skills. Excel proficiency will make you a valuable asset to the business. As a result, many employers specifically request Excel experience as a requirement in their job specifications. 
 
    Staying updated on new technology has become a full-time task as Microsoft platforms continue to grow. Microsoft Excel will continue to be the most popular platform for analyzing data, creating charts and presentations, and integrating with powerful tools for visual dashboards and business intelligence workflows. 
 
    Businesses are increasingly turning to Excel for data collaboration and accessibility. In the next few years, we will see MS Excel's future moving at a rapid pace to provide multi-user access to vast data for research, reporting, and significant improvements in production and efficiency. 
 
    Custom solutions are essential in today's diverse economic environment to retain a competitive advantage and maximize profits. Microsoft Excel consultants are the most knowledgeable about current and new technology. Having a retained specialist consultant is critical to achieving the maximum power and efficiencies needed to succeed in the twenty-first century. 
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